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Welcome to COMAND!

Please make yourself familiar with your
COMAND control unit and read the instruc-
tions in this manual before operating the
COMAND system. This will help you derive
a greater benefit from the system. Please
also follow the instructions and warnings
contained in this manual. Ignoring them
could result in damage to the vehicle or
personal injury to you or others.

The asterisk* identifies optional equip-
ment. Depending on model, version and
configuration, your COMAND system
equipment may differ. Therefore, you may
find explanations for optional equipment
not installed in your vehicle. If you have
any questions about the operation of any
equipment, your authorized Mercedes-
Benz Center will be glad to demonstrate
the proper procedures.

—

We continuously strive to improve our pro-
duct and ask for your understanding that
we reserve the right to make changes in
design and equipment. Therefore, informa-
tion, illustrations and descriptions in this
manual might differ from the equipment in-
stalled in your vehicle. As such, the infor-
mation, illustrations and descriptions
contained in this manual may not be reaso-
nably relied upon in making any claims
with respect to the actual performance of
the product.

These operating instructions form an inte-
gral part of the vehicle and should there-
fore always be kept inside the vehicle and
passed on to the new owner if the vehicle
is sold.

We extend our best wishes for many miles
of safe, pleasurable driving.

Mercedes-Benz USA, LLC
A DaimlerChrysler Company
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V Where to find it

This Operator’s Manual is designed to pro-
vide support information for you, the
COMAND operator. Each chapter has its
own guide color to provide fast access to
information.

|
At a glance

Here you will find an overview of

all COMAND control elements and system
components. If you are operating
COMAND for the first time or if you have
rented or borrowed the vehicle, this is the
chapter you should read first.

|
Audio

Here you will find all the information on
how to use the radio, CD player (CD,
MP3-CD), CD changer* and DVD drive.

%
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|
Satellite radio*

This chapter provides information on how
to select a station and a program category.
|
Telephone*

Here you can learn in detail about the
many functions of the telephone, how to
initiate an emergency call and use the pho-
ne book.

|
Navigation

This chapter provides detailed information
on the following topics:

e Destination input
e Route guidance including detour

e Last destinations and destination
memory

e POls

Introduction

Where to find it

|
Service

Here you will find all the information about:
e SMS

e Address book

e Tele Aid*
|
System settings

This chapter provides information on how
to adjust COMAND system settings.
|
Directories

The glossary explains the most important
technical terms.

The table of contents and index directory
will help you quickly locate the information
you need.
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.

Symbols

V Symbols

You will find the following symbols in these » This symbol points to instructions for
operating instructions: Warning A you to follow.

* The asterisk identifies optional » A number of these symbols appearing

. . Warning notices draw your attention to ha- . Lo .
equipment. Since not all models . in succession indicates a multiple-step
zards that may endanger your health or life,

have the same standard equip- . or the health of life of others. procedure.
ment, your COMAND system equip- NN
ment may deviate from some
descriptions and illustrations.

The continuation symbol
| marks an interrupted proce-
dure which will be continued

Highlights hazards that may result in on the next page.

damage to your COMAND.
(> page 9)  This symbol tells you where

to look for further infor-
(i ]

mation on this subject.
Helpful hints or further information you

may find useful. -> This symbol is used in the

glossary. It indicates that
the term immediately follo-
wing the symbol is also exp-
lained in the glossary.

Display Messages, menu items or
soft key names appearing in
the COMAND color display
are printed in the type
shown here.
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Introduction

Operating safety
V Operating safety

Warning A

Warning A

Any alterations made to electronic compo-
nents and the software can cause malfunc-
tions.

The radio, amplifier, CD changer*, satellite
radio*, telephone*, navigation module and
voice control system* are interconnected.
When one of the components is not operati-
onal or has not been removed/replaced pro-
perly, the function of other components may
be impaired.

This condition might seriously impair the
operating safety of your vehicle.

We recommend that you have any service
work on electronic components carried out
only by qualified personnel.

In order to avoid distraction which could
lead to an accident, the driver should enter
system settings with the vehicle at a stand-
still and operate the system only when road
and traffic conditions permit.

Bear in mind that at a speed of just

30 mp/h (approximately 50 km/h), your car
is covering a distance of 44 feet (approxima-
tely 14 m) every second.

COMAND supplies you with information to
help you select your route more easily and
guide you conveniently and safely to your
destination. For safety reasons, we encoura-
ge the driver to stop the vehicle in a safe
place before answering or placing a call, or
consulting the COMAND screen to read na-
vigational maps, instructions, or downloa-
ded information.

%

While the navigation system provides direc-
tional assistance, the driver must remain fo-
cused on safe driving behavior, including
attention to traffic and street signs, and
should utilize the system’s audio cues while
driving.

The navigation system does not supply any
information on stop signs, yield signs, traffic
regulations or traffic safety rules. This al-
ways remains your personal responsibility
when you drive. DVD maps do not cover all
areas nor all routes within an area.
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At a glance

Radio operating elements

CD operating elements

Satellite radio* operating elements
Telephone* operating elements
Navigation system operating elements
Service operating elements

Menu system

Quick reference COMAND
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% At a glance

Radio operating elements

V Radio operating elements

A

TEL
UV

MUTE EJECT
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Function Page
Audio menu 34
Soft keys

(multifunction keys)

Color display with Radio
main menu

H-HE
Station selection 38
Saving stations manually 40

Selecting a station from
the preset memory 42

@ Confirm

P ee® O

Function
(<«J>rBallv
Function selection
[ o EUCE v |

e.g.
Automatic seek tuning

Kl and

e.g. Manual tuning
Muting

Volume control

@ Switching on and off
and
Automatic seek tuning

Manual tuning

Page

37
37
34
28

27

37
37

At a glance

Radio operating elements
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% At a glance

CD operating elements

»

V CD operating elements

TEL

RPT

4/15

MUTE

00:18

EJECT
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Function
Audio menu

Soft keys
(multifunction keys)

CD changer* main menu

CD/DVD slot

o

The CD changer* is

located in the trunk.

-
Selecting a CD (CD
changer* only)

Track select
@ Confirm

Page
34

47

49
51

EliE

Function

Kland I3

Selecting a CD (CD
changer* only)

Selecting a folder
(MP3-CD)

N ond K4
Track select

Selecting a track
(MP3-CD)

CD ejection

Muting

Page

49

58

51

58
47

53

e® e 6

At a glance

Function

Volume control

@ Switch on/off
and

Track select

Fast forward/reverse

Selecting a track
(MP3-CD)

Skip track (MP3-CD)

CD operating elements

Page
28
27

50
52

58
59
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% At a glance

Satellite radio* operating elements

V Satellite radio* operating elements

A

TEL : The Pulse

MUTE EJECT

P82.86-4105-31US
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% At a glance

Satellite radio* operating elements

Function Page Function Page
(@) Satellite radio main menu 80 @

Switching satellite radio Muting 81

operation on and off 80 T — 28
@ Soft Ifeys i ® @ Switching on and off 27

(multifunction keys)

. . ®. B and

(® Colorscreen with Satellite 0

radio main menu Previous or next channel 81
® H-H

Station selection 82

Saving stations manually 83
® @ Confirm
OM <§ > 84l v]

Function selection
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% At a glance

Telephone* operating elements

V Telephone* operating elements

Phone Number:

SEEK+

_-IDD

MUTE EJECT

P82.86-4106-31US

I/

I

A
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% At a glance

Telephone* operating elements

Function Page Function Page Function Page
@ Soft keys @ & Confirm @ Ef

(multifunction keys) Ol «f>8fAfvEN | Muting the ringing tone or 97,
@ Color screen with rmeiiton sl ending a call 99

Telephone menu

- ® e Volume control 28

® B Sseapiling o el 97 ® @ Switching on and off 27

Entering the unlock code 95 ) TEL

Entering a telephone aKingialcat ”?

et 08 Redialing 99 Telephone menu 96

o Switching telephone
Speed-dialing 102 operation on and off 92
Quick-dialing 102
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Navigation operating elements

V Navigation operating elements

Continue Route Guidance
Destination Memory
Destination Entry

Last Destinations

POls

SEEK+

MUTE EJECT

P82.86-4107-31US
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% At a glance

Navigation operating elements

Function Page Function Page
@ Soft keys ©® i
(VI TETe ) Repeating current voice
@ Color screen with instruction 139
Navigation main menu Switching on volce
® @ Confirm instructions 140
® KON @ Volume control 28
[\ N /| @ Switching on and off 27
Function selection ® DI
® Navigation main menu 118
During a voice instruction: During route guidance:
Muting current voice Change over to navigation
instruction 140 display 140

Switching off voice Cancelling route guidance 143

instructions 140 [ maP |
Switches to map display 140
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Service operating elements

V Service operating elements

AUDIO SAT

TEL

-SEEK SEEK+

MUTE EJECT

P82.86-4108-31US

7

N
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% At a glance

Service operating elements

Function Page
@) Soft keys
(multifunction keys)
(@ Color screen with Service
main menu
® M-
Input functions
@ @ Confirm
OM <§>8 4l v]
N A
Function selection
® @ Switching on and off 27
@
Service main menu 168




At a glance

Menu system
V Menu system

The menu system allows for easy
operation of COMAND.

Main menus are provided for the following
main functions:

e Audio
(Radio, CD, CDC*, MP3-CD, DVD)

e Satellite radio*
e Telephone*
¢ Navigation

e Service

Calling up main menus
Audio (> page 34):

> Press .

Satellite radio* (I> page 80):

> Press B3
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Telephone* (> page 96):
» Press EEN.

Navigation (> page 118):

» Press [
Service (> page 168):

> Press B

Menu display

A display may consist of three areas.

Example: FM menu

[EEEE|
We__| @

Treble

e
2 o]
) Oz
o]
oo

<4 95.7 FM »~
v
o | oo
Radio @  Fm9 T

P82.86-4058-31US

(@ Soft key sections
(@ Main area
(® Status bar

The functions currently assigned to the
soft keys are displayed in the soft key
sections (1.

o

A maximum of five soft keys may be
displayed on each side of the main area

®.

ﬁ
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The main area (2) shows messages and
settings.

You can change the settings by operating
the system.

The status bar (3) is divided into three
areas.

Left side:
The current operating mode is indicated. In
this example: Radio

Center:
The status of the current operating mode

or other selectable functions are indicated.

In this example:
e [M = current waveband

e 9 =memory location of station,
e‘g' “9”

%

Right side:

General status information is indicated
independent of the operating mode.

In this example:

e Ready = Telephone* is ready for
operation

o I = Reception strength of the
mobile phone

Menu functions and submenus

Using the soft keys, functions can be
switched ON or OFF, or submenus can be
called up.

At a glance

Menu system

Example: Radio main menu:

Prests | [ bass
W | R
B . 957 Fy » - BB
£ o]

v
[Autost. |_Back

. LEELY
Radio —unl

FM9
P82.86-4059-31US

e The FM/AM soft key switches between
FM and AM band.

e The Scan soft key starts/stops the
channel scan.

In some situations, soft keys may not have
any function and are not operational. A
soft key without function appears shaded
out.
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At a glance

Menu system

Example Phone book:
Page A (O) soft key

< D > B
A DextAer, Paul @
ooy LR
v

Ready

01808122002 il

P82.86-3964-31US
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Exiting from submenus

Use the Back soft key to exit a submenu.
The display switches to the next higher
menu level.

The system will save all changes you have
made. There are exceptions in which
pressing the Back soft key will not resultin
the settings being saved. The exceptions
are expressly described on the following
pages.

ﬁ
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V Quick reference COMAND

%

o

You have the following options to
control the system:

e at the COMAND

e at the multifunction steering wheel
(refer to vehicle Operator’s Manual)

e using the Voice control system*
(refer to separate operating
instructions for further information)

This Operator’s Manual describes the
control at the COMAND.

Unless otherwise indicated, the
descriptions and illustrations refer to
the COMAND.

Switching the COMAND control unit
on and off

Switching on

» Turn the key in the steering column
lock to position 1 or 2.

or
» Press @.

In both cases, the system will activate
the operating mode which was active
when the system was switched off.

o

If the key is not in the steering lock in
position 1 or 2, the system will
automatically stop after around 30
minutes. A warning is displayed prior to
the system switching off.

At a glance
Quick reference COMAND

Switching off

» Turn the key in the steering column
lock to position 0 and pull the key out.

or

> Press @.

Volume

The volume is adjusted jointly for the
telephone*, the navigation system and the
Voice control system.

The volume setting applies to other
operating modes as well: Radio, CD,
CD changer*, MP3-CD and DVD.

When you adjust the volume, the system
will automatically store the setting for the
current operating mode. The volume for
the navigation announcements can only be
changed while an announcement is being
made.
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At a glance

Quick reference COMAND

Adjusting the volume

>

or

At the COMAND, turn the rotary control
at the @ key.

Press or &l on the

multifunction steering wheel.

The volume is turned up or down
depending on the direction of rotation
or the key pressed.

The system remembers the volume
setting when it is switched off.

When the system is switched on again,
the volume may be lower than at the
time when the system was switched
OFF.

This will be the case when the volume
was adjusted to a value outside a
certain range when the system was
switched off.
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Automatic volume control

The automatic volume control feature
adjusts the volume depending on:

vehicle speed (only in vehicles without
sound system*)

or

ambient noise inside the vehicle (only
in vehicles without sound system*)

other parameters (e.g. windows open
or closed)
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At a glance
Quick reference COMAND

The balance settings for navigation » Press the Balance soft key.
announcements are described at “Audio
settings for the navigation
announcements” (> page 121).

Balance
Cross-hairs are displayed. The
horizontal line indicates the balance
setting. You can now make balance
When you change balance settings, the settings.

e CD operation (single CD) system will automatically save the settings

for the current operating mode and others. m <P Balance

Common balance settings apply to the
following sytems:

e Radio operation

e CD changer* operation

* MP3-CD operation Setting balance W :
. FM/AM

* DVD operation In Radio, CD, CDC*, MP3-CD, DVD or .

e Satellite radio* satellite radio* operation: B2 | Sound|

Different balance settings can be set for
. . Ready
navigation and telephone*. Radio FM2 —=nl]

P82.86-4055-31US

o -
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% At a glance

or

Quick reference COMAND

Press |Kll or I

Move the cross-hairs horizontally and
adjust the balance.

Press @ or the Back soft key.

Wait until the display changes.

The new setting is saved.
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Bass and Treble

Different bass and treble settings are
possible for the following operating
modes:

e Radio operation (FM and AM band)
e (D operation (single CD)

e CD changer* operation

e MP3-CD operation

e DVD operation

e Satellite radio* operation

e Navigation operation

The Bass/Treble settings for navigation
announcements are described at “Audio
settings for the navigation
announcements” (> page 121).

e

When you adjust Bass or Treble, the
system will automatically save the settings
for the current operating mode.

Activating the Bass or Treble menu

In Radio, CD, CDC*, MP3-CD, DVD or
satellite radio* operation:

» Press the Bass or Treble soft key.

The Bass or Treble menu will appear.
You can now make bass or treble
settings (> page 31).

ﬁ




Bass and Treble Control

» Activate the Bass or Treble menu
(> page 30).

+

FM/ AM Balance
= 4 .......... I ..........
Ready
Radio —mi[]

P82.86-4056-31US

» Press Kl or I

Bass or Treble is adjusted.
» Press @ or the Back soft key.
or
» Wait until the display changes.

The new setting is saved.
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Sound functions*

If your vehicle is provided with the sound
system*, the sound functions* will be
available for the following operating
modes.

e Radio operation

e CD operation

e MP3-CD operation

e DVD operation

o Satellite radio* operation

The following sound functions* are
available:

e Factory Setting:
COMAND set the sound functions* to
factory setting for the active source
mode.

e Default:
COMAND set the sound linear for the
center of the vehicle.

%

At a glance
Quick reference COMAND

e Speech optimized:
Playback optimized for language
comprehensibility.

You can use different sound functions* for
the modes mentioned above.

Example:

For CD operation the function

Default, for DVD operation the function
Speech optimized.
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At a glance

Quick reference COMAND

Activating the sound functions*

A
In Radio, CD, CDC*, MP3-CD, DVD or mFactory Setting m
satellite radio* operation: mgefau: 5 ; g
peech-Optimize
» Activate the main menu for the GNVEN
respective operating mode Scan | _ Sound
(> page 24) hiost | v
» Press the Sound soft key. . Ready
Radio FM2 -=n0l]
The Sound menu appears. P82.66-4057-31US
» Press [ or B4 to select the desired
function.
» Press .

The function is activated.
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Audio menu
Radio operation
CD operation
MP3-CD operation
DVD operation




Audio menu
V Audio menu

In chapter “Audio” you will find detailed
information regarding

e Radio operation

e (CD operation

e MP3-CD operation
e DVD operation

If you have not done so already, please fa-
miliarize yourself with these functions by
reading chapter “At a glance”.
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Opening the Audio menu

» Press [T

DVD

AUDIO

Ready
-mil

P82.86-4104-31US

Audio menu

» Ifan audio submenu is displayed, press
the Back soft key until the Audio menu
is displayed.

or
» Press [QY again.

Selecting an audio source

» In the Audio menu, press the soft key
for the desired audio source, e.g.
Radio.

Muting

Switching On
» Press [MGH

The system mutes the active audio
source.

Switching off
» Press again.

or

> Press S, IEEEH, &8 or B or any

of the available soft keys for the active
audio source.

ﬁ
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V Radio operation

Switching the radio operation on The station last tuned in is received.

» In the Audio menu, press the Radio ()

soft key. The Sound soft key appears if the

COMAND is provided with sound
functions* (> page 31).

The Radio main menu will appear.

®
WB : ) A Treble
-4 95 7 FM >@ » Press the Back soft key

| Sound|

v

Radio @  Fmo S

Switching back to Audio menu

P82.86-4061-31US

Radio main menu

(@ Soft key assignment
(@ Main area
(® Status bar

Radio operation

Changing the Radio band

You can select between FM-, AM- and WB-
Band.

AM Band

» In the FM Radio main menu, press soft
key FM/AM until “AM” is displayed in
the status bar.

The AM station last tuned to will begin
to play. The frequency will appear in
the display.

Prosts | [ bass
Wo | R
_41080 AM>+
I Em

v

ook

Ready

Radio AM —=u00

P82.86-4063-31US
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Radio operation

Switching back to FM or AM band

Frequency band Frequency range m
FM 87.7 - 107.9 FM — R » Press the FM/AM soft key.
AM 530- 1710 AM The station last tuned to will begin to

= <Channe| 1} + play.

Weather Band (WB)

v Switching back to Audio menu
» Inthe FM or AM Radio main menu, S
press the WB soft key. — — » Press the Back soft key.
Radio WB -=n0l]

An automatic scan is starting and the

COMAND plays and displays the first

strong WB station. (i ]
With the number keys [l - B8 it is pos-
sible to choose a channel.

P82.86-4064-31US

.

e
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Radio operation

Selecting a station Automatic seek tuning Manual tuning (FM, AM)
You can use the following functions: > Press [RE0 or G » Activate the desired wave band
> page 35).
e Automatic seek tuning (> page 37) or (> page 35)
» Press or B33 longer than 2 se-
e Manual tuning (> page 37) » Press ¥ or K& condsm 8
* Station selectionfrom the Presetmenu  gyy oy 01 Bands, Weather Band (WB) The function is active.

(> page 37)
Station selection via direct frequenc The radio will tune in to the next receivable  or
o i ion via dir uency . .
station (FM, AM) or channel (WB) with de- p
ress or I
entry (FM, AM) (> page 39) scending/ascending frequency depending K3
e Automatic station scan (FM, AM) on the direction of seek. The frequency will change by the tuning
(> page 39) increments for the respective

Stati lection f he EM/AM W8 waveband each time one of the buttons
* Station selection from the FM/ Alternatively, you can select the channel is pressed.
Autostore presets (> page 43) directly:

FM Band
» Press a number key [} through BA.

The frequency displayed will change in in-

o crements of 0.2 MHz.
The selected channel is not shown in
the status line. AM Band

Tuning will take place in increments of
10 kHz.

o -
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Radio operation

*

Station selection via number keypad Station selection via direct frequency Frequency band  Frequency range

(presets) entry (FM, AM) aueney —
. FM 87.7 - 107.9 FM

FM and AM Bands E.g.: 102.7 MHz in the FM band AM 530- 1710 AM

» Activate the desired waveband
» Press one of the number keys, such as

> page 35).

briefly. (> page 35)

o Press [l
The radio will tune to the frequency as- . )
signed to that memory location. If none An input line will appear.
has been set by.you, the radio willnot -, Enter the desired frequency with the
change the station. number keys within 8 seconds, e.g.
o for 102.7 FM.
FM and AM presets are independent The.station you have selected will
and can only be accessed while in the begin to play.

corresponding band.

Saving stations for FM and AM
(> page 40).

@%

e
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Radio operation

FM, AM band Automatic station scan (FM, AM) Start scan function
Entries outside the frequency range are The stations in a given waveband (FM, AM)  » Activate the desired wave band
not possible. can be scanned one after the other for 8 (> page 35).

() seconds each. » Press the Scan soft key.

The scan function stops automatically
when the first station received has been
scanned twice.

The scan function will begin. Scan will
appear in black lettering.

If you do not make another entry within
8 seconds, the function will be canceled

and you will listen to the station last tu-
ned to. () End scan function and play a station

Station scan performs two runs. During  » Press the Scan soft key again if you
the first run, stations with good hear the desired station.

reception are played. During the

second run, stations with weaker

reception are played.

o e
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Radio operation

Memory functions
You can use the following functions:

e Saving stations manually (FM, AM)

e Saving stations automatically FM, AM

(> page 41)

e Selecting a station from the FM/AM
Preset menu (> page 42)

e Selecting a station from the FM/AM
Auto presets (> page 43)

Saving stations manually (FM, AM) On the memory list

. i » Activate the desired waveband
In the Radio main menu (&> page 35)
» Activate the desired waveband > Press the Presets soft key.
(> page 35).
The memory Preset menu will appear.
» Pressone of the number keys, e.g. [, y PP

longer than 2 seconds.

You will hear a confirmation beep if the 1:°87.9 2: 95.7 3:101.9

WB . Y . Treble
beep tones option was activated in the - ;2:,: glg g: 182'; g: 122'57’ -
system settings (> page 201). VBN " 01027
The radio saves the current station at m m
the memory preset selected. The me- m W
mory preset selected will appear in the : =
status line, e.g. “FM2”. Radio FM2 -=n0l

P82.86-4065-31US
i > Use I8, I3 o N, I to highlight
There are 10 presets available (" - the desired memory preset,

2 2 JB

An existing entry is overwritten in the
memory list when a new input is given.

» Press @ longer than 2 seconds.

The current station will be saved at the
memory preset selected.

You will hear a confirmation beep if the
beep tones option was activated in the
system settings (> page 201).

e .




A
ZINd

You will see the Radio main menu
e automatically after 8 seconds

e if you press the Back soft key.

o

There are 2 presets for each of the FM
and AM waveband, standard FM/AM
presets (saving stations manually) and
Auto presets (saving stations automati-
cally).

The standard FM/AM presets are not
affected by the Auto presets. This is a
second option for storing a station ran-
ge you are currently receiving.
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Saving stations automatically (FM, AM)

» Activate the desired waveband
(> page 35).

» Pressthe Autost. soft key.

The autostore presets will appear.

m Reprogram Autostore ﬂ

SRS 1 87.9 2: 95.7 3:101.9
L 2: 013 5: 987 6:105.5

3: 94.3 8:103.3 9: 95.7

—

Ready

Radio FM —=nf]
P82.86-4066-31US

> Press @ and confirm Reprogram
Autostore.

The autostore function is active. The
radio stores the 10 stations with the
strongest signal. The station
frequencies available will appear in the
memory list.

%

Radio operation

o

There are 10 presets available ([l -
)
The autostore function assigns the sta-

tions to the memory locations in the or-
der of their reception quality.
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Radio operation

o

Selecting a station from the preset » Press the corresponding number key, » Press .
2 . )

menu (FM, AM) e.g. [, to select the desired station. In both cases, you will see the Radio
» Activate the FM or AM memory or main menu

(> page 40). » Use [KI I or M. B4 to highlight a e automatically after 8 seconds
You can use one of the following two ways memory preset in the FM/AM preset « if you press the Back soft key.
to select a station from the FM/AM list.
presets The Radio main menu indicating the

memory preset number appears.

.

e
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Radio operation

Selecting a station from the FM/AM
autostore presets

» Activate the FM or AM autostore pre-
sets (> page 41).

» Use [KI IX or N, B4 to highlight a

memory position.

> Press .
You will see the Radio main menu
e automatically after 8 seconds

o if you press the Back soft key.

o e




CD operation
V CD operation

General Information on CD operation

Warning A
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Warning A

In order to avoid distraction which could
lead to an accident, the driver should insert
CDs with the vehicle at a standstill and
operate the audio system only if permitted
by road, weather and traffic conditions.

Bear in mind that at a speed of just 30 mph
(approximately 50 km/h), your car covers a
distance of 44 feet (approximately 14 m)
every second.

The CD drive and CD changer* are Class 1
laser products. There is a danger of invisible
laser radiation when you open or damage
the cover.

Do not remove the cover. The CD drive and
the CD changer* do not contain any parts
which can be serviced by the user. For safe-
ty reasons, have any necessary service work
performed by qualified personnel.

o

COMPACT

DIGITAL AUDIO
Only use CDs, which bear the label

shown and that conform to the compact

standard (IEC 60908). You can there-
fore only use CDs with a maximum
thickness of 1.3 mm.

%

e

(i

The COMAND CD drive may not be able
to play audio CDs with copy protection
or copied CDs.

Use only CDs with a diameter of 12 cm,
do not use 8-cm CDs.

An 8-cm CD adapter may cause dama-
ge to the CD changer* or to the
COMAND and should not be used.

o

Your CD drive has been designed to
play CDs which correspond to the IEC
60908 standard.

If you insert thicker data carriers, e.g.
ones that have data on both sides (one
side with DVD data, the other side with
audio data), they cannot be ejected
and will damage the drive.

ﬁ
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CD operation

Tips on caring for your CDs
e Only touch the CD on the edge.

e Avoid touching the CD surface with
your fingers.

Clean the CD with a dry, lint-free cloth.
Wipe them from the inside to the outer
edge. Never wipe the CD in a circular
motion.

e Do not use rubbing alcohol or solvents
to clean the CDs.

Do not expose the CDs to heat or direct
sunlight.

Do not write or put stickers on CD.

o e
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CD operation

() Current track /number of tracks on the Loading CDs

Switching to CD operation
current CD

Playback locations for audio CDs are:

(3 Elapsed playback time of the current . A
« the CD drive in the COMAND track R
e the CD changer*. (7 ) In order to avoid distraction which could
Differences regarding the CD mode depen- The CD-Mag soft key is only assigned lead tq an accide.nt, the driver sh9u|d insert
ding on the audio source are highlighted. when the CD changer* is active. CDs with the vehicle at a standstill and
) operate the audio system only if permitted
> Inthe Audio menu (> page 34.): press The Sound soft key appears if the by road, weather and traffic conditions.
the CD @ soft key (for CD drive) or COMAND is provided with sound Bear in mind th d of iust 30 mph
the CD @) soft key (for CD changer*). functions* (> page 31). Sl [T £ 6] EpEee @1 S0 i
(approximately 50 km/h), your car covers a
. distance of 44 feet (approximately 14 m)
CD-M < CD 4 > D
=8 m CD drive every second.
~ PN
[Show | T The CD drive in the COMAND can ()
[Scan | i | Sound| playback audio CDs, ME:”‘CDS The COMAND may be unable to
: (> page 55). The slot of the drive is playback audio CDs provided with copy
(2) [ Back| above the display. protection.
o@D 2/15 00:18 @
pe2sed0s03ius D changer®
CD changer* main menu o
(D CD changer* CD @) or CD drive The CD changer* can accomodate up
C(h @ to 6 audio CDs. It is located on the left-

hand side behind the driver’s seat.

@%
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CD operation

Loading a CD into the CD drive After that the message Loading Ejecting/loading CDs into/from the CD
o Medium Please Wait will appear. changer*
A CD already loaded must be eiected After loading, the CD main menu The CD changer* is located on the left-
y ) (> page 46) will appear. Playback hand side behind the driver’s seat. Open

before inserting a new CD. Inserting a
second CD with another CD still loaded
will cause damage to the CD drive
which is not covered by the Mercedes-

begins with track 1 of the CD inserted.  panel cover to access the CD changer*.

Ejecting a CD

Benz Limited Warranty. » With the COMAND switched on, press
eiccr)
> Insert a CD into the slot (> page 14). The system ejects the CD already loa-
The CD should be inserted with the ded. RIS
label side up.
] Remove the CD from the slot.
The COMAND pulls the CD into the
drive. The display changes. ()

If you do not remove the CD from the
slot within around 15 seconds, the
COMAND will pull the CD into the drive

again.

— [@@ » Insert another CD into the slot. The CD
should be inserted with the label side
up.

P82.86-4070-31US

%
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CD operation

¢

Removing the magazine: » Repeat these four steps to load more

A ; Switching on
CDs into the magazine.

» Slide the cover of the CD changer*
open.

» Press the green Y button on the
CD changer*.

Reading the magazine in: CD drive

» Activate the Audio menu (> page 34).
» Pressthe CD @ soft key.

» Slide the magazine into the CD changer
until it clicks into place (listen for the

The magazine will slide out.

o

You can also slide out the magazine if
COMAND is switched off.

However, the Y button will not
function If the battery is not connected

click).

o

When you push the magazine in, the
arrow on the upper side of the
magazine must point in the direction of
the CD changer*.

The CD main menu is displayed.

If no audio CD has been inserted, the
message No CD appears.

» Load an audio CD into the CD drive
(> page 47).

CD changer*

or drained. The CD changer* reads the magazine.

The message Magazine Scan
Please Wait will appear.

» Activate the Audio menu (> page 34).

Inserting CDs into the magazine: > Press the CD @) soft key.

» Pull the disk tray forward until it stops. Slide the cover of the CD changer* The CD changer* main menu will

» Remove any previously inserted CD. closed. appear.

» Place a CD in the tray. The CD should The CD last played begins to play.
be inserted with the label side up.

» Push the CD tray into the magazine

completely.

ﬁ
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A Treble

Balance

Track 4

v

cp0 @) 4/15 00:18 Sannl
P82.86-4071-31US
CD changer* main menu

If the last played CD is not available, the
next available audio CD is played back.

o

The name of the CD and the track
played are displayed if the information
is available.

ﬁ%
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No magazine in the CD changer*:
The message No Magazine will appear.

» Load audio CDs into the CD changer*
(> page 47).

No CD in the magazine:

The message Magazine Empty will
appear.

» Load audio CDs into the CD changer*
(> page 47).
Selecting a CD (CD changer* only)
You can select a CD:
e inthe CD list (> page 49)
e with the number keypad (> page 50)
e in the Magazine menu (> page 50)

CD operation

In the CD list

o

Selection is possible if the
CD changer* has loaded the magazine
and at least two audio CDs are loaded.

The CD list includes all loaded CDs. Only
one list entry is visible at a time.

The entry is displayed above the track
indication. It shows the number or the
name of the CD currently playing.

> Use I or Kl to select another CD
from the list.

After the CD is loaded, it is played
back.

or
» Do not change the selection.

Playback of the last played CD is
continued.
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. CD operation

With the number keypad In the Magazine menu » Use [IY or [E4 to select a CD.
0 » Press the CD-Mag soft key. » Press @.
The number keys [Jill - [kl can be used The Magazine menu is displayed. If the  or
for direct selection. magazine has not been read in, the

y e S » Press one of the number keys [Jiij to
) . message Magazine Scan
Keys Il - B} correspond with Please Wait is displayed first. .

magazine slots 1to 6 The CD is changed.
of the CD changer* X

Track select

1 CD 1
» Press a number key, e.g. to select 2 CD 2 You can select a track:
the corresponding CD. 3 CD3
) i m4 CD 4 o with J3EER or BEIq (> page 51)
The CD is changed. The selected CD is m 5 m
- e inthe track list (> page 51)
pesbeet e’ ==

e with the number keypad (> page 51)

cp @) 4/15  00:02 0 with CD track scan (> page 52)

P82.86-4072-31US

.
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With [ or TR

» Activate the CD main menu
(> page 46).

Next track

» Press BE28.
The next track is played.

Previous track or start of title (if more
than 10 seconds of playing time has
elapsed)

> Press B
Playback begins.

Select any desired track

» Press R34 or as often as
necessary.

%

In the track list

The track list includes all tracks of the CD
currently played. Just one list entry is
visible at a time which shows the number
of the track currently played.

» Press N or K&

The track list with the current, the
previous and the next track is
displayed. The previous or next track is
played.

> Use [[¥ or B4 to select another track
from the list.

The selected track is played.

e

CD operation

With the number keypad

» Activate the CD main menu
(> page 46).

» Press Kl

An input line will appear in the main CD
menu.

c0 @) 4/15 00:02 oann

P82.86-4073-31US

CD 4
Treble

Balance

Track __

E.g.: Track 3
» Press A
E.g.: Track 12.

> Press il and in short succession.

ﬁ
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CD operation

(i ] Fast forward/reverse
CD-Mag
Entries higher than the number of - CD 1 m

» Activate the CD main menu
tracks on the CD are not possible.

(> page 46).
show (UGS
» After entering the track number, wait - o m

approx. 3 seconds.

Fast forward

 Setting | » Press longer than 2 seconds and

The selected track is played. The CD keep it pressed.

main menu is displayed. c0 @) 1/15 00:18

P82.86-4074-31US Fast reverse

0 » Press P34 longer than 2 seconds and
When you start the scan function, the keep it pressed.

playback mode Normal Sequence

(> page 54) is automatically activated.  Ending the function

CD track scan

The tracks on a CD can be scanned one
after the other for 8 seconds each. The
function will switch off automatically when
the starting track is reached. You can also

; » Release H33g or Bk
manually stop the scan function. Ending the function SEEK
Playback will resume.
Activating Scan search is running.
» Press the Scan soft key. > Press the Scan soft key.
Scan will begin. or
» Press .
Playback will resume with the desired
track.

—$— —+|®
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be

Muting Playback mode
On The following options are available:

» Press during playback. ¢ Normal Sequence (> page 54)

The CD operation is muted and the ]
symbol is displayed on the status bar. ¢ CD Mix (> page 54)

e Track Mix (> page 54)

e Repeat Track (> page 54)
e Repeat CD (> page 54)

Off
» Press again.

Playback will resume. Activating playback mode

The X] disappears from the status bar. E.g.:

() Mode Repeat Track
COMAND will also deactivate muting if ), prass the Sett i ng soft key.
you

) The setting menu will appear.
e select another audio source (e.g.

radio) ()

e change the volume If the CD changer* is connected, the
. playback modes Repeat CD and
* press either (R or EEEG. CD Mix are also available.

%

CD operation

Normal Sequence O

Track Mix @] Treble
CD Mix O]

Repeat Track @) Salance
Repeat CD

v

1/15 00:18

P82.86-4075-31US

CD changer* setting menu

> Use 1Y or B4 to select the playback
mode Repeat Track.

> Press @.

The mode is activated. Wait a few
seconds for the CD changer* main
menu to appear. The activated mode is
displayed on the status bar (except
Normal Sequence).
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. CD operation

Explanation of the playback modes

Normal Sequence

Tracks are played in ascending order
(e.g. 1,2,3and soon).If justone CD is
inserted, the first track is played when
the last one is over.

If more than one CD is available, the
first track of the next CD is played
when the last track of the previous CD
is over. The CDs are changed in normal
order.

Track Mix

Tracks are played in random order. If
more than one CD is available, the next
available CD is played when the current
CD is over. The CDs are changed in
normal order.

CD Mix (CD changer* only)

At least 4 tracks of any CD are played
in random order. Then follows the next
available CD. The CDs are changed in

random order.

e Repeat Track

The system repeats the current track
until you switch the function off.

e Repeat CD (CD changer* only)

The system repeats the current CD
until you switch the function off.

@%
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V MP3-CD operation

General Information

Warning A

Warning A

ﬁ%

In order to avoid distraction which could
lead to an accident, the driver should insert
CDs with the vehicle at a standstill and
operate the audio system only if permitted
by road, weather and traffic conditions.

Bear in mind that at a speed of just 30 mph
(approximately 50 km/h), your car covers a
distance of 44 feet (approximately 14 m)
every second.

The CD drive and CD changer* are Class 1
laser products. There is a danger of invisible
laser radiation when you open or damage
the cover.

Do not remove the cover. The CD drive and
the CD changer* do not contain any parts
which can be serviced by the user. For safe-
ty reasons, have any necessary service work
performed by qualified personnel.

o

When you create a MP3-CD you can
define structures and input information
in addition to the title information.

MP3-CD operation

o

The COMAND plays the tracks on the
MP3-CD in alphabetical order. To
preserve the order on the original CD,
number the tracks in ascending order
when you record them.

The smallest possible data rate for
MP3-CDs is 56 KB/s.

o

The COMAND does not play back
MP3-CDs containing files with ISO
9660 Level 3 standard. Such MP3 CDs
contain fragmented files.
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MP3-CD operation

Tips on caring for your MP3-CDs Switching to MP3-CD operation )
o Treat MP3-CDs with care to prevent » Activate the MP3-CD main menu Warning A
[functi ing pl k.
malfunctions during playbac (> page 57). Bear in mind that at a speed of just 30 mph
* Do not scratch, touch or soil your MP3-  or (approximately 50 km/h), your car covers a
CDs. ; .
» Load an MP3-CD into the COMAND distance of 44 feet (approximately 14 m)
e Do not attach labels to or write on your (> page 56). every second.
MP3-CDs.
e Fromtime to time, cleanyour MP3-CDs ~ CD drive (i
with a commercially available cleaning (i} A CD already loaded must be ejected
cloth. Never wipe circularly, but in a ) before inserting a new MP3-CD.
straight line from inside to outside. Zh.e MP3-CDs alre ZI?V?;%'n the same Inserting a second MP3-CD with
rive as normal audio CDs. ; ;
o After use, put your MP3-CDs into the o . another CD still Ioadgd will cause
CD box The MP3-CD drive is above the display. damage to the CD drive which is not
’ covered by the Mercedes-Benz Limited
e Protect your MP3-CDs from high Loading an MP3-CD Warranty.

temperatures and direct sunlight.
A » Insert a MP3-CD into the slot

(> page 14). The MP3-CD should be
inserted with the label side up.

Warning

In order to avoid distraction which could

lead to an accident, the driver should insert The COMAND pulls the MP3-CD into
CDs with the vehicle at a standstill and the drive. The display changes.
operate the audio system only if permitted

by road, weather and traffic conditions.

.
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compACT

DIGITAL AUDIO

P82.86-4070-31US

After that the message Loading
Medium Please Wait will appear.

After loading, the MP3-CD main menu
(> page 57) will appear. Playback
begins.

Ejecting an MP3-CD

» With the COMAND switched on, press
EJECTH

The system ejects the MP3-CD already
loaded.

» Remove the MP3-CD from the slot.

o

If you do not remove the MP3-CD from
the slot within around 15 seconds, the
COMAND will pull the MP3-CD into the
drive again.

» Insert another MP3-CD into the slot.
The MP3-CD should be inserted with
the label side up.

MP3-CD operation

MP3-CD main menu
» Activate the Audio menu (I> page 34).
» Press the MP3-CD soft key.
or
» Load a MP3-CD (> page 56).

The MP3-CD main menu will appear.

[ZXE3 <« My Top 100 Single » ﬂ

A
| Sound]
X

MP3-CD 23/100

023 Elvis vs JXL

v

00:18 @

P82.86-4077-31US

MP3-CD main menu

(@ Current track /number of tracks on the
current MP3-CD

(@ Elapsed playback time of the current
track
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MP3-CD operation

The first line shows the name of the
current folder. At the center you see the
currently played track.

Selecting a folder

>

Activate the MP3-CD main menu.
(> page 57).

Use [Kll or I to select a folder.

The track list only displays the tracks of
the selected folder.

Playback of the first track of the

In the track list

The track list includes all tracks of the
selected folder of the currently played

MP3-CD. Only one list entry is visible at a

time.

» Open the MP3-CD main menu
(> page 57).

» Press |4 or M-

The track list is displayed. You will see

up to 3 entries. The track shown in
black is the one currently playing.

With the number keypad
» Activate the MP3-CD main menu

(> page 57).

In short succession, press button
and the number key of the desired
track, e.g. 24.

o

If the current folder contains less
tracks, the system will only recognize
the first digit entered and play the ap-
propriate track.

selected folder will begin.

» Press KA )
Selecting a track » After your entry wait approx. 3
You move forward through the track seconds.

You can select a track: list.

. . The selected track is played. The
* Inthe track list (> page 58) > Press 4. MP3-CD main menu will appear.
* with the number keypad (> page 58) You move backward through the track
o with EE or (> page 59) list.

e with MP3-CD track scan (> page 59)

.

2
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Skip Track

» Activate the MP3-CD main menu
(> page 57).

Forward

> Press BEQ

The next track from the track list is
played.

Backward

> Press B

If the track has been playing for more
than approx. 10 seconds, the track is
replayed from the start. If the playing
time is shorter, the previous track is
played.

ﬁ%
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MP3-CD track scan

The tracks of the current folder can be
scanned one after the other for 8 seconds
each. Subfolders are not considered.

The function will switch off automatically
when the starting is reached.

You can also manually stop the scan
search.

Starting the Scan Search

» Activate the MP3-CD main menu
(> page 57).

» Press the Scan soft key.

o

When you start the scan search, the
playback mode Normal Sequence

(> page 60) is automatically activated.

MP3-CD operation

Ending the scan function
Scan search is running.

» Press the Scan soft key.
or

> Press .

The last scanned track is played back.
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MP3-CD operation

Playback mode Explanation of the Playback Options

The following options are available: e Normal Sequence

Normal Sequence
Folder Mix
CD-ROM Mix

Folder |
e Folder Mix (> page 61) m Repeat Track
‘Setting |

Treble
The tracks of the current folder are

e N I'S > 60
ormal Sequence (i page 60) Balance played in alphabetical order.

. Repeat Folder If the current folder contains sub-
e CD-ROM Mix (> page 61)

(OXONGNONC)

v Back folders:
* Repeat Track (> page 61) MP3-CD 23/100 01:01 R0 The sub-folders and their tracks are
e Repeat Folder (> page 61) P82 86.4076.31US played in alphabetical order.
L » Use [N or [E@ to select the playback The current folder does not contain
Activating playback mode mode Normal Sequence. sub-folders:
Eg: » Press @. The track of the folder next in the

Option Normal Sequence alphabet is played back.

The option is activated. Wait a few
> Press the Setting soft key. seconds for the MP3-CD main menu to ()

appear.

The Settings menu is displayed. After selection, the following playback

options are displayed on the status bar.
Option Symbol

Function active @

Function not active ~ O

@%

2

e 4|




be

e Folder Mix

The tracks of the current folder and its
sub-folders are played in alphabetical
order.

e (D-ROM Mix

All tracks of the MP3-CD are played in
random order.

e Repeat Track

The system repeats the current track
until you switch the function off.

e Repeat Folder

The system repeats the tracks of the
current folder until you switch the
function off.
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MP3 options

Folder

Use the Folder option to navigate
through the structure of an MP3-CD.

Opening the folder menu

» Activate the MP3-CD main menu
(> page 57).

» Pressthe Folder soft key.

The names of the folders on the current
MP3-CD are displayed.

o

Only those folders or sub-folders are
displayed which contain the MP3
tracks.

MP3-CD operation

/Root
#3 Daten . °
e s
#3 Top Country

o [
MP3-CD 23/100 00:18 @)  ZawcO

P82.86-3974-31US

(@ Current track /number of tracks on the
current MP3-CD

(2 Elapsed playback time of the current
track

> Use I or KA to select a folder.
> Press @.

The list of the tracks in the folder is
displayed. 5 tracks are displayed.
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MP3-CD operation

/Root/My Top 100 Single Y Displaying title information

A » Activate the MP3-CD menu main
A 001 Eminem - Without me (> page 57)
# 002 Shakira - Underneath your )
4003 Tiziano Ferro - Perdono 8 » Press the Show soft key.

#4004 B3 - l.o.i.o

4005 Xavier Naidoo - Bevor du

The information on the current track

v stored on the MP3-CD is displayed.
MP3-CD  01/100 00:18 0
P82.86-3977-31US W < My Top 100 Single » ﬂ
» Use ¥ or K@ to navigate through the 023 Elvis Presley vs

JXL - A little less

track list. m
» Press the Play soft key. m
or Setting | | Back|

» Press @ to play the selected track. MP3-CD  23/100 00:30 Roadr 1
e Soft key tr1: P82.86-4078-31US
Brings you one level up in the folder
structure.

RE —| @
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DVD operation

V DVD operation

General information on DVD operation Automatic screen off
Warning A
[
Warning A The CD/DVD drive is a Class 1 laser pro- The COMAND system is capable of
ducts. There is a danger of invisible laser ra- playing DVDs. However, in order to

In order to avoid distraction which could

diation when you open or damage the cover. avoid driver distraction, the video func-
lead to an accident, the driver should insert

tion is disabled and no images will be

; ; : Do not remove the cover. The CD/DVD drive
DVDs with the v.ehlcle ata stan.dstlll a?d g conta s which ) shown on the COMAND screen.
operate the audio system only if permitted USS e Germizzn gy [PEInEs WIAlE Crln 150 S2r=
by road, weather and traffic conditions. viced by the user. For safety reasons, have

Upon loading a DVD, the following mes-

any necessary service work performed by .
sage will appear:

Bear in mind that at a speed of just 30 mph qualified personnel.

(approximately 50 km/h), your car covers a To prevent the driver from being

distance of 44 feet (approximately 14 m) distracted, the picture is faded
every second. 0 out.
Your CD/DVD drive has been designed
to play CDs/DVDs which correspond to
the IEC 60908 standard.

e Treat DVDs with care to prevent
malfunctions during playback.

e Do not scratch, touch or soil your

If you insert thicker data carriers, e.g. DVDs

ones that have data on both sides (one

side with DVD data, the other side with ® Do not attach labels to or write on your
audio data), they cannot be ejected and DVDs.

will damage the drive.

%
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. DVD operation

From time to time, clean your DVDs
with a commercially available cleaning
cloth. Never wipe circularly, but in a
straight line from inside to outside.

After use, put your DVDs into the DVD
box.

Protect your DVDs from high
temperatures and direct sunlight.

DVD playback requirements

o

Vendors may offer DVDs which do not
comply with the standards.

Sound, picture and other playback
problems may occur when you play
such DVDs.

The COMAND can playback video
DVDs meeting the following
requirements:

e Regional code is set (factory
setting)

e NTSC or PAL TV standard

The appropriate information is usually
given either on the DVD or the DVD
box. The factory setting of the
COMAND is regional code 1. The
setting can be changed at an
authorized Mercedes-Benz Center. This
will allow you to playback video DVDs
with other regional codes, as long as
they comply with the NTSC or PAL TV
standard.

%

(i

The COMAND system is capable of
playing DVDs. However, in order to
avoid driver distraction, the video
function is disabled and no images will
be shown on the COMAND screen.

Switching to DVD operation

>

or

>

Load a video DVD into the COMAND
(> page 65).

If a DVD is already loaded, open the Au-
dio menu (> page 34) and press the
DVD soft key.

If the video DVD meets the playback re-
quirements, playback will begin. If avai-
lable, the DVD menu (> page 70) saved
on the DVD will appear.

ﬁ
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Loading a DVD

Warning A

In order to avoid distraction which could
lead to an accident, the driver should insert
DVDs with the vehicle at a standstill and
operate the audio system only if permitted
by road, weather and traffic conditions.

Bear in mind that at a speed of just 30 mph
(approximately 50 km/h), your car covers a
distance of 44 feet (approximately 14 m)
every second.

o

A DVD already loaded must be ejected
before inserting a new DVD. Inserting a
second DVD with another DVD still loa-
ded will cause damage to the DVD
drive which is not covered by the
Mercedes-Benz Limited Warranty.
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>

(i

Your CD/DVD drive has been designed
to play CDs/DVDs which correspond
to the IEC 60908 standard.

If you insert thicker data carriers, e.g.
ones that have data on both sides (one
side with DVD data, the other side with
audio data), they cannot be ejected
and will damage the drive.

o

A DVD already loaded must be ejected
before inserting a new DVD. Inserting a
second DVD with another DVD still
loaded will cause damage to the DVD
drive which is not covered by the
Mercedes-Benz Limited Warranty.

Insert a DVD into the slot (> page 14).
The DVD should be inserted with the
label side up.

The COMAND pulls the DVD into the
drive. The display changes.

%

DVD operation

2 (5

VIDEO DIGITAL AUDIO

P82.86-4070-31US

After that the message Loading
Medium Please Wait will appear.
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. DVD operation

If the video DVD meets the playback Further error messages are: Ejecting a DVD
r?ﬂubirements (> page 64), playback o VD > With the COMAND switched on, press
will begin. )
& No DVD inserted in the slot. [EsECTH
If available, the DVD menu (> page 70 .
saved on the DVD will appéarp & ) » Load a DVD (> page 65). The system ejects the DVD already loa-
' . ded. The message No DVD will appear.
. . e No Valid DVD
If the video DVD does not have regional R the DVD £ the slot
code 1 (> page 64), the following Cannot read DVD. > Remove the rom the slot.
message appears: QVD Carmot be » Load a DVD (> page 65) which o
E] Zyed - Invalid Regional meets the DVD playback require- If you do not remove the DVD from the
oae. ments (> page 64). slot within around 15 seconds, the
e DVD Error COMAND will pull the DVD into the

. drive again and close the slot.
DVD cannot be read or is damaged.

» Load another DVD (> page 65). » Insert another DVD into the slot.
e DVD Device Error
The drive may be damaged.

» Contact an authorized Mercedes-
Benz Center.

@%
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DVD operation
Soft key display and status bar Eg.
When you start DVD playback, the soft key Bright e Ttl. 5=Track/movie no. 5 is being
displays and the status bar are initially - played

blanked out. Sce. 1=Scene/chapter 1is being

played

Displaying the soft keys

e (0:00:47 =DVD playing time elapsed

» Inthe DVD mode, press any soft key. (47 seconds)

DVD Ttl. 5 Sce. 1 0:00:47

rpe2.86282831us  1he soft keys and the status bar are auto-
matically blanked out again. You can also
blank out the display manually.

The soft keys and the status bar are

displayed.
DVD playback with soft key display and

status bar

The DVD information is displayed at the To remove the soft key display

t f the status bar.
genterotthe status bar » Pressthe Full Scr. soft key.

o e
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. DVD operation

Soft key functions . ; ?t’|€1 ngt EOfItD\IjeDy: " Pause function
ISplays the setlings menu » Display the soft keys (> page 67).
o (> page 71). play ys (> page 67)
Depending on the DVD, not all func- e Sound soft key: > Press the Pause soft key.
tions are available at any time. Brings you to the sound menu, where DVD playback is paused. The picture
you can set: stands still. The Pause soft key
e Pauseor Play soft key: changesto Play.
Switches the Pause function on or off * Balance (> page 29) > To resume plavback. press the P1a
u ,
(> page 68). e Bass and Treble (> page 30) soft key piay P Y
e Stop soft key: e Sound functions* (> page 31)

Stops the DVD playback (> page 69). Playback of the DVD will resume.

e Bright.,Contr. and Color soft

e Full Scr. soft key: keys:
The soft key display disappears Allow you to adjust brightness, cont-
(> page 69). rast and color (> page 74).

e Menu soft key:
Displays the DVD menu saved on the
DVD, if available (> page 70).

.
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Stopping DVD playback
» Display the soft keys (> page 67).
» Press the Stop soft key.

DVD playback stops.

Restarting DVD playback

» After playback has stopped, press the
Play soft key again.

The DVD is played from the start.
or

» Select a movie (> page 74).

ﬁ%
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o

While DVD playback is stopped, you
can press the Menu soft key.

The DVD menu saved on the DVD is dis-
played, if available (>> page 70).

Displaying full screen

» During DVD playback with the soft keys
displayed press the Full Scr. soft
key.

The soft keys disappear. The full screen
will appear.

DVD operation

Activating DVD menu

» Display the soft keys (> page 67).

» Press the Menu soft key.
The highest level of the DVD menu is
displayed, if available (> page 70).

Activating Settings menu

» Display the soft keys (> page 67).

» Press the Setting soft key.

The DVD settings menu will appear
(> page 71).




¢
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DVD operation

DVD menu

The DVD menu is the menu saved on the
DVD. The structure of the menu may vary
depending on the DVD and allows certain
settings or actions.

For example, multilingual DVDs allow the
DVD language to be selected in the menu.

Activating DVD menu
» Display the soft keys (> page 67).
» Press the Menu soft key.

Depending on the DVD, the highest le-
vel of the DVD menu is displayed.

o

In order to avoid driver distraction, the
video function is disabled and no
images will be shown on the COMAND
screen. The message To prevent
driver from being distracted,
the picture is faded out ap-
pears.
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» Remove the soft key display if necessa-
ry (> page 67).

The soft keys are automatically remo-
ved after a while.

Selecting an item from the DVD menu

» Use I} Kl N or B4 to select a

menu item.
» Press .

Your selection is confirmed. The
COMAND will perform the action defi-
ned by the menu item selected.

o

If you press Y for longer than two
seconds, you may display additional
functions if available. The kind of func-
tion depends on the DVD menu.

Going up one level in the menu

A DVD menu may contain several subme-
nus. Submenus may include a menu item
to go up one level in the menu.

» Select the appropriate menu item
(> page 70).

e

ﬁ
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You can also proceed as follows:
» Display the soft keys (> page 67).

» Pressthe Menu soft key once or several
times.

With each depression of the soft key
you will move up one or several menu
levels (depending on the DVD) until the
topmost level is reached.

Removing DVD menu

A DVD menu or a submenu may include an
item for closing the DVD menu.

» Select the appropriate menu item
(> page 70).

You can also proceed as follows:

» Display the soft keys (> page 67).

ﬁ%
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» Press the Back soft key.
or
» Press the Stop soft key.
DVD playback is stopped and the DVD

menu is opened.

Settings menu

zoom |

I
[ seck

DVD Ttl. 5 Sce. 1 0:00:04

P82.86-2830-31US

Settings menu

DVD operation

Setting options:

4:3,16:9 or Zoom soft key:
You can change the aspect ratio
(> page 72).

Lang. soft key:
You can change the DVD language
(> page 72).

e Subtitle soft key:
You can display and switch between
the subtitles (> page 73).

e Angle soft key:
You can change the camera view
(> page 74).
Activating the Settings menu
» Display the soft keys (> page 67).
» Pressthe Setting soft key.

The Settings menu will appear.
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DVD operation

Changing the aspect ratio

The system will automatically select the
appropriate aspect ratio when a DVD is
played back.

You can manually change the aspect ratio
during playback of the DVD. To do this, use
the top left soft key. The soft key changes
each time you press it.

Possible aspect ratios are: 4:3, 16:9 and
Zoom.

The soft key indicates the aspect ratio to
which you will change when you press the
soft key.

Zoom is useful to watch movies in
cinematic aspect ratio. You can use the
function to reduce the width of the black
bars at the top and bottom.

» In the Settings menu (> page 71),
press the soft key repeatedly until the
desired aspect ratio is set.

Changing the DVD language

o

You can only change the DVD language
if the DVD supports several languages.

Changing the DVD language:

» During playback of the DVD, activate
the DVD settings menu (> page 71)

» Press the Lang. soft key.

The language list is displayed. The con-
tent of the list depends on which langu-
ages the DVD supports.

Use [N or A to select a language.
Press @.

The selected language is set.

o

The Lang. soft key has no function if
the Settings menu is activated from
within the DVD menu.

In this case, you need to change the
language in the DVD menu (> page 70)
if the menu item is available. Or remove
the DVD menu (> page 71) and again
press the Lang. soft key in the
Settings menu.

Some DVDs allow the language to be
selected additionally or exclusively in
the DVD menu saved on the DVD

(> page 70).

ﬁ

@%

AW

2



A
ZINd

t

g%% 230 Audio US B.fm Seite 73 Mittwoch, 8. Dezember 2004 4:28 16

o

The system cannot read languages in
DTS format. If you select such a langu-
age, the movie is played without sound.

Displaying and switching between sub-
titles

o

These functions are available only if the
DVD supports subtitles.

o

When you insert a DVD, subtitles are by
default switched off.

» During playback of the DVD, activate

%

the DVD settings menu (> page 71).

or

Press the Subtit1e soft key.
The subtitles list will appear. The

content of the list depends on the DVD.

Use [N or A to select a subtitle.
Press .

The selected subtitles are used.

Use Y to select list entry
No subtitles.

Press .

Subtitling is switched off.

DVD operation

o

The Subtitle softkeyhasno function
if the Settings menu is opened from
within the DVD menu. In this case, you
need to change the subtitles in the
DVD menu (> page 70) if the menu
item is available.

Or remove the DVD menu (> page 71)
and again press the Subtitles soft
key in the Settings menu.

Some DVDs allow the subtitling func-
tion to be selected additionally or ex-
clusively in the DVD menu saved on the
DVD (> page 70).
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DVD operation
Changing the camera view () » Pressthe Brightn., Contr. or
(7 ) The Angle soft key cannot be selected CoTor soft key.

if the Settings menu is activated from ~ » Press | or K

You can only change the camera view if
g 8 within the DVD menu (> page 70).

several camera views are stored on the
DVD. The number of available In this case, select the camera view in
camera views depends on the DVD. the DVD menu.

The respective setting is changed.

Selecting a movie

If several movies are on the DVD, you can
select a movie directly.

Movies can be selected while the DVD is
played back or stopped.

Some DVDs supporting different
camera views don’t offer a switch
option. In this case, select the camera
» Press the Angle soft key. view in the Settings menu.

» During playback of the DVD, activate
the DVD settings menu (> page 71)

A list of the available camera views will E.g.: Select movie no. 3

appear. Adjusting brightness, contrast and » Press [EA.
» Use ¥ or [ to select the desired colc-)r The 3rd movie starts after a short
camera view. > Display the soft keys (I page 67). while.
> Press @. [
The selected camera view is used. Movie selection may also be possible in
the DVD menu saved on the DVD
(> page 70).

@%
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Selecting a scene/chapter

If the movie is divided into chapters or sce-

nes, you can directly jump to a chapter or
scene or skip them while the movie is
playing. Some DVDs will not allow this in
certain portions of the movie (e.g. during
screen credits, age restriction and/or pa-
rental advisories).

Selecting a scene or chapter directly
E.g.: Scene/chapter 5
» While the movie is playing, press [ll-

» Press Kl

After a short while playback starts from
the 5th chapter or the 5th scene.

ﬁ%
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o

Chapter/scene selection may also be
possible in the DVD menu stored on
the DVD (> page 70).

Scene/chapter skip
> Press FEg or BENR.
Button = Next chapter or scene

Button 324 = Previous chapter or
scene or beginning of scene if scene
has been playing for more than 10
seconds

DVD operation

Fast forward/reverse

> Keep or M pressed during DVD
playback.

= fast forward
B = reverse

Release the button to stop fast
forward/reverse.
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Satellite radio*

Important notes

Satellite radio operation
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Satellite radio*

Important notes

V Important notes

In chapter “Satellite radio”, you will find
detailed information regarding

selecting a station and a program cate-
gory
memory functions

sound adjustments

If you have not done so already, please fa-
miliarize yourself with these functions by
reading chapter “At a glance”.

o

Additional optional satellite radio equip-
ment and a subscription to satellite ra-
dio service provider are required for the
satellite radio operation described here.
Contact your authorized Mercedes-
Benz Center for details and availability
for your vehicle.

o

Note that categories and channels
shown in illustrations are dependent on
programming content delivered by the
service provider. Programming content
is subject to change. Therefore, channel
and categories shown in illustrations
and descriptions contained in this ma-
nual may differ from the channels and
categories delivered by the service pro-
vider.

Satellite radio service may be unavai-
lable or interrupted from time to time
for a variety of reasons, such as envi-
ronmental or topographic conditions
and other things we can’t control. Ser-
vice might also not be available in cer-
tain places (e.g., in tunnels, parking
garages, or within or next to buildings)
or near other technologies.

e

o

Sirius Satellite Radio provides approxi-
mately 100 channels, so called
streams, of digital-quality radio, among
others music, sports, news, and enter-
tainment commercial-free.

Sirius Satellite Radio uses a fleet of
high-power satellites to broadcast 24
hours per day, coast-to-coast, in the
contiguous U.S.

This diverse, satellite-delivered pro-
gramming is available for a monthly
subscription fee. For more information
and service availability, call the Sirius
Service Center (> page 79) or contact
www.siriusradio.com.

ﬁ
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Subscribing to satellite radio

o

If the Satellite radio function has not yet
been subscribed to or not subscribed
again, you have to contact the satellite
radio service provider.

» Press to switch to satellite radio
operation.

One of the two following screens will
appear:

e the Satellite radio main menu dis-
playing the Preview channel or

e the Service information display

Satellite radio*

Important notes

m < ENTERTAINMENT b m
info |

o Bass |
888-539-7474 (1)

Preview Your ESN is
% 000224115430@ m
Ready Ready
SAT Ch.184 —=nl] SAT Ch.184 —=nlll

P82.86-4083-31US P82.86-4090-31US

Satellite radio main menu (Preview channel)  Service information display

The Satellite radio main menu displays the
Preview channel. You cannot select any
other station.

(® Phone number of the provider,
(SIRIUS) or “Call Service Provider”
(@ The Electronical Serial Number (ESN)

> Press the SIRIUS soft key to display the of your satellite receiver

Service information display. » Contact satellite radio service provider
at the telephone number displayed in

the screen.
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Satellite radio*

Satellite radio operation
V Satellite radio operation

After the connection is made: After the COMAND acquires the
signal, the Satellite radio main menu will

appear. The station last tuned to will begin

Switching on

» Follow the instructions given by the See “Subscribing to satellite radio” for im-
operator. portant subscription information

The activation process may take up to (> Page 79).

10 minutes. If it is successful, you will  p press to switch to satellite radio < POP @ > B
see the display with the message operation.

A
The Pulse @
Info [ Sound

Acquiring Signal...
D Em B h (2) -y

P82.86-4079-31US

Acquiring Signal... (> page 80)
followed by the Satellite radio main
menu (> page 80).

o

Credit card information may be re-
quired for your application.

v

—

(o]
=3

Q
=<

o
[\
=

If a satellite receiver is not installed or
not properly installed: SAT

Satellite radio main menu

P82.86-4060-31US (® Program category
(@ Station name

(® Memory preset selected and channel
number

The message No Satellite Radio
will appear. When switching to Satellite radio ope-

ration, the system may have to acquire
the signal. The signal may also be inter-
rupted from time to time during opera-
tion for a variety of reasons

(> page 78) and may have to be re-
acquired. If so, you will see the above
message on the display.

e
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Satellite radio*

Satellite radio operation

(i ] Changing the program category Selecting a station
You can display (2) in full: Satellite radio stations are split up into ca-  You can use the following functions:
e Station information (> page 84) tegories. You can select between various Automatic tuning
categories such as News, Sports News and
Muting Country Music, if available. The category ~ ® Automatic station scan (> page 82)
list is sorted alphabetically. o Station selection via direct channel

» Press while listening to the satel-
entry (> page 82)

lite radio. Selecting a program category Stati ection f h ;
N . . ation selection from the preset menu
Ehe symbol K] will appearin the symbol > Use Kl or I3 while the Satellite radio (> page 84)
ar. main menu (> page 80) is being
» Press again to resume listening to displayed. Automatic tuning

the current station. .
The previous or next program category . jge K2 or I while the Satellite radio

The symbol K] will have disappeared. (alphabetical order) will appear in the main menu is being displayed.
display. The station last tuned in the

(i) new category will begin to play. or

Muting will also be canceled if you > Press I or =8

switch to an audio source, e.g. normal

radio, or if you alter the volume. The satellite radio will tune in to the nu-

merically previous or next receivable
station in the selected category.

o -
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Satellite radio*

Satellite radio operation

Automatic station scan Ending scan function and playing a » Enter the number of the channel you
i i 515
The stations in the selected category can station wish to select, e.g. [RIRN-
be scanned in numerical order for 8 se- » Press the Scan soft key again. The channel you have selected will be-
conds each. The station selected will appear with gin to pl,ﬂy' The co.r%rets;?[gnd!ng Stfﬂlt'gln
» In the Satellite radio main menu, press the station name. Scan will appear in name will appear, It station Is avaniable.
the Scan soft key. white lettering again. ()
The scan function will begin. Scan will Station selection via direct channel If the selected channel is not subscri-
appear in black lettering. bed, the system displays Channel Not
entry .
subscribed.
*
m ﬂ > Press [l If no content is being broadcast on the
Info | Input line will appear. selected channel, the system displays
The Pulse the message Invalid Channel.
- =3 s
- e
EI;’I!E Back
SAT Ch.2 “eanl Channel _ _ _
P82.86-4085-31US m m
E
SAT Sl

P82.86-4084-31US

e
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Memory functions

o

There are 10 presets available.

You can use the following functions:
e Saving stations manually

e Selecting a station from the Satellite
preset memory (I> page 84)

e Selecting a station by entering the
channel number (> page 82)

%

Saving station manually

In the Satellite radio main menu

» Pressone of the number keys, e.g. 4,

longer than 2 seconds.

You will hear a confirmation beep if the
beep tones option was activated in the
system settings (I> page 201).

The satellite radio saves the current
station at the memory preset selected.
The memory preset selected will ap-
pear in the status line, e.g. SATZ.

Satellite radio*

Satellite radio operation

On the memory list

» In the Satellite radio main menu, press
the Presets soft key.

The SAT preset memory will appear.

> Use K4 or ¥ to select a memory pre-
set.

> Press @ longer than 2 seconds.
You will hear a confirmation beep if the
beep tones option was activated in the
system settings (> page 201).

The satellite radio saves the current
station at the memory preset selected.

o

An existing entry is overwritten in the
memory list when a new input is given.
You will see the Satellite radio main menu

e automatically after 8 seconds

e if you press Y.
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Satellite radio*

Satellite radio operation

Selecting a station on the memory list » Pressthe Back soft key to switch back

Displaying information A h ;
to the Satellite radio main menu.

» In the Satellite radio main menu, press  p |n the Satellite radio main menu, press

the Presets soft key. the Info soft key.
The SAT preset memory will appear. The information display will appear.
Presets | A B0 EEE the Trend [
1 The Pulse Artist: Culture Club
3 Speedvsn Title: It's A Miracle
ey
5 Spirit ml ml
mé Hardatak m
SwiUs | v Sins | oaci]
Ready eal
SAT -=n00 il sAT Ch.2 oun0
P82.86-4086-31US P82.86-4089-31US
» Use M or KA to highlight a memory You will see (if available)
reset.
P e the full station name
» Press .

e additional program information
The Satellite radio main menu will then

appear automatically after 8 seconds,
indicating the memory preset number
in the status line.
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Satellite radio*

Satellite radio operation

Displaying service information » Pressthe Back soft key to switch back

. . to the Satellite radio main menu.
You can call the provider service center for

questions or releases, whenever youneed.  Sound settings

» Press the STRIUS soft key. Refer to chapter “At a glance” on how to

The Service information display will ap- adjust sound settings.

You can set

e the sound Bass/Treble individually

| Bass|
888-539-7474 (1)

e select predefined sound optimization

e the sound-center (Balance)

Your ESN is

000224115430 @

Ready

Ch.184 -=n0

P82.86-4054-31US

(@) Phone number of the provider,
(SIRIUS) or “Call Service Provider”

() The Electronical Serial Number (ESN)
of your SAT tuner

o e
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Satellite radio*
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Important notes

Telephone operation
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Telephone*

Important notes
V Important notes

In chapter “Telephone”, you will find de-
tailed information regarding the telepho- Warning A

. . Radio transmitters, such as a portable
ne*, including emergency call.

telephone or a citizens band unit
should only be used inside the vehicle
if they are connected to a separate ex-
terior antenna that has been approved
by Mercedes-Benz.

Some jurisdictions prohibit the driver from
using a mobile phone while driving a vehicle.
Whether or not prohibited by law, for safety
reasons, the driver should not use the mobi-
le phone while the vehicle is in motion. Stop
the vehicle in a safe location before answe-
ring or placing a call.

If you nonetheless choose to use the mobile
phone while driving, please use the hands-
free device and be sure to pay attention to
the traffic situation at all times. Use the mo-
bile phone1 only when road, weather and
traffic conditions permit.

Never operate radio transmitters equipped
with a built-in or attached antenna (i.e.
without being connected to an external an-
tenna) from inside the vehicle while the en-
gine is running. Doing so could lead to
malfunction of the vehicle’s electronic sys-
tems, possibly resulting in an accident and
personal injury.

1 Observe all legal requirements

—$— —+|®
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o

If you have a Mercedes-Benz specified
integrated mobile telephone (TDMA/
CDMA or GSM) and the telephone is
inserted in the cradle, the telephone
functions can be used as follows:

e at the COMAND
e at the multifunction steering wheel
e with the Voice control system*

This instruction manual describes the
operation at the COMAND. Unless
otherwise indicated, the descriptions

and illustrations refer to the COMAND.

Operation at the mobile phone and
operation with the Voice control
system* are described in separate
operating guides. Refer to the vehicle
Operator’s Manual for operation of the
telephone using the multifunction
steering wheel.

Which soft key functions are available
depends on the mobile phone variant.

o

In certain menus, the COMAND can
display date and time of the calls.

The COMAND can display phone
number and name of the other party
(e.g. if the COMAND detects an
incoming call, but also in other menus).
For the number to be displayed, the
number information must be
transmitted with the incoming call. The
same goes for the name display which
additionally requires that the caller’s
number and name are saved in the
phone book.

Telephone*

Important notes

o

No ring or DTMF tones will be heard
when a phone set to silent mode is in-
serted into the cradle.

For ringtone settings, refer to the sepa-
rate operating instructions for the
mobile phone.
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Telephone*

e

Important notes

Please read the chapter “Telephone”
first before attempting to operate your
telephone.

Please also read the important notes in
the telephone and Voice control sys-
tem* operating manuals.

Always drive with extreme caution
when you operate the telephone
hands-free.

For safety reasons, you should not use
the mobile telephone handset to make
a call while driving the vehicle.

If the signal strength is very weak (dis-
play in the symbol bar of all menus):

Wait until reception improves before
making a call.

Close the windows and reduce all out-
side noise as much as possible when
you use hands-free operation.

Also make sure that the air vents are
not pointed in the direction of the
microphones located in the overhead
control panel near the rear view mirror.
Adjust air vents and/or reduce blower
speed if necessary.

A brief disconnection from the cellular
network is not a malfunction, as this
can occur when the network switches
areas. The phone will automatically try
to sign on to a network again.

If the message Enter Unlock Code:
appears, enter the unlock code to en-
able all telephone functions

(> page 92). If you do not do so, only
the emergency call (911) is available.

GSM mobile phone

If the message Enter PIN: onthe
COMAND appears, enter the PIN-code
to enable the telephone functions

(> page 92). If you do not do so, only
the emergency (911) callis available on
the COMAND.

%

In the following situations, it is not possible
or not yet possible to use the telephone:

The telephone is already unlocked but
is not or not yet registered in the net-
work.

The message no Serv. appearsin the
status bar. The telephone will try to re-
gister into an existing network. If the
network is available, the telephone will
be ready for use.

The above message also appears

e ifthe network is no longer available
due to weak signals

e if you try to make a call (message
Service Unavailable appears
for 8 seconds)



¢

ﬁ%

The message Activating Telepho-
ne Please Wait appears.

COMAND prepares the telephone for
use. Select other system functions, e.g.
radio, by pressing the corresponding
button or wait until the telephone is ac-
tive.

The message Telephone Unavai -
lable appears if telephone* is not in-
stalled or a malfunction has occured.

Please contact an authorized
Mercedes-Benz Center.
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The message Telephone Not In-
serted appears if the mobile phone is
not inserted in the cradle.

Please connect the mobile phone.

o

Depending on power state of the phone
it may take up to 8 seconds from phone
insertion until this message disappears
(e.g. if a powered-off phone is inser-
ted).

Telephone*

Important notes

GSM mobile phone

If the message Check SIM Card
(Emergency Call “911” Only
Possible With Tel.):

» Insert the SIM card into the mobile
phone (Telephone Operating
Manual).
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% Telephone*

Telephone operation

V Telephone operation

Switching telephone operation on GSM mobile phone:

. » Enterthe PIN and, if necessary, the
Automatically unlock code for the mobile phone.
The telephone* is automatically activated If no SIM card is in the telephone,

when the COMAND is switched on. The

the message Check SIM Card ap-
mobile phone must be inserted in the

pears.
mobile phone cradle* at the time
COMAND is switched on. (i)

In this case, you can dial the emergen-
Manually cy call 911 on the telephone only.

» Press EEN.
The menu to enter the unlock code
(> page 95) will appear (only if phone
has been locked before). Switching telephone operation off

» Switch the COMAND off (> page 27) or
turn off the engine.

» Insert a SIM card. Refer to the mo-
bile phone operator’s manual.

The telephone* is switched off with a
time-lag of around 10 minutes. You
cannot make an outgoing call or accept
an incoming call within that time.

%

or

>

In the Telephone menu (> page 94),
press longer than two seconds.

The message Deactivating Tele-
phone will appear.

@%

2

ol
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Emergency call “911” e TDMA/CDMA mobile phone

(i The emergency call will also be placed

i ) if the phone is locked (> page 94).
This function places a call to the local

911 provider. It does not initiate a * GSM mobile phone
Tele Aid* call. If no SIM card is in the phone or SIM
PIN is not entered, you can only make
You can make an emergency call to an an emergency call at the mobile phone.

emergency rescue station with a mobile

communication network. Emergency calls may not be possible with

all mobile phone networks or if certain net
The emergency call will be placed as long  work services and/or telephone functions

as the corresponding mobile communicati-  are active. Check with your local network
on network is available. To do this, switch  operating company.

the telephone on if you have not already
done so.

If you cannot make an emergency call, you
must initiate rescue measures yourself.

o -

Telephone*

Telephone operation

Warning A

The 911 emergency call system is a public
service. Using it without due cause is a cri-
minal offense.
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Telephone*

Telephone operation

Initiating an emergency call > Press @ to confirm Yes if youwantto  » Press repeatedly until the
Telephone is locked place the “911” emergency call. telephone menu is displayed.
The emergency call will be placed. > Press A, and [l one after the
KX  Enter Unlock Code: I ) \ait until the emergency rescue other.
* % * % station answers and describe the » Press @ or press the Send soft key.
emergency.

The emergency call will be placed.

Ea):ﬁu do not want to place the emergency it il the emergency rescue
: station answers and describe the
» Press i to select No when the emergency.
TEL inquiry menu appears. o

P82.86-3984-31US .
Press @ to confirm No. .
> @ Ending the emergency call:

» Press the 911 soft key.

The system opens an inquiry menu Telephone is ready for operation Depending on the cellular network, it
may be necessary to press the [EX

prompting if you want to dial a “911” :
button on the mobile phone.

call.
Telephone Number:

The selection marker in the inquiry |
menu should be on Yes. p=

» If necessary, press K to select
Yes.
Ready

TEL -un0l]

P82.86-4080-31US

e 4@
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Telephone*

Telephone operation

Entering codes () GSM mobile phone

Your unlock code prevents unauthori-
zed persons from using your mobile
phone. Be sure to memorize this code,a » Enter the PIN code for the mobile pho-

Entering the unlock code Entering the PIN code

» Use the number keys il through IEll

to enter the four-digit unlock code.

Asterisks instead of digits will appearin
the input line.

four digit number, carefully.

If you enter an incorrect code, the sys-
tem returns to the menu for entering the
unlock code.

ne. Refer to the mobile phone opera-
tor’s manual on how to do this.

If no SIM card is in the mobile phone,
the message Check SIM Card ap-

» Press the 0K soft key. pears

m Enter Unlock Code: m o » Insert a SIM card. Refer to the mo-

You must always enter the unlock code bile phone operator’s manual.
when you switch on the telephone the
first time (if mobile phone is in locked

mode)

* Kk k .
Entry incorrect:

You will hear a warning sound.

» You need to re-enter your PIN code.

TEL Warning A

P82.86.3984.31US If the PIN is entered incorrectly three

times in a row, the SIM card will be
blocked. The message SIM Card
Blocked is displayed briefly. After
that the message PIN Blocked
Please Enter PUK on Cell Phone
is displayed.

When in the enter unlock code screen, the
emergency number 911 (default input) will
be dialed if you press “1” longer than 2 se-
conds. The 911 emergency call system is a
public service. Using it without due cause is
a criminal offense.

If entered code is correct and the mobi-
le phone is registered in a network, the
mobile phone is ready for use.

—@

%
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Telephone*

Telephone operation

Entering the PUK The telephone is ready for operation

Switching to telephone operation

If you enter your PIN incorrectly three When the COMAND is switched on, you Message Ready and the reception
times in a row, you need to enter the PUK  can switch to telephone operation from strength «unllll are shown on the status bar.
number. any other system (e.g. radio): Other messages
0 » Press . e Roaming
The PUK number is provided by your The Telephone menu will appear. The mobile phone is using a non home
mobile phone service provider. type system
no Serv.
The PUK can only be entered at the mobile Telephone Number: *
phone. Refer to the mobile phone | The mobile phone is not logged into a
operator’s manual. é: network
Fault messages:
Telephone Not Inserted
TEL =l > Plug the mobile phone into the mobile

phone cradle*. Refer to the separate
mobile phone operator’s manual.

P82.86-4080-31US

Telephone Unavailable

Your vehicle may not have a mobile phone
cradle* installed and/or the telephone
control unit may not be coded properly.
Contact an authorized Mercedes-Benz
Center.
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You can use the following functions in the
telephone menu:

Entering a telephone number
(> page 98)

Use the redial function (> page 99)

Displaying the dialed numbers list
(> page 100)

Displaying the received calls list
(> page 101)

Use speed-dialing (> page 102)
Use quick-dialing (> page 102)

Displaying the phone book
(> page 104)

Adjusting balance settings (> page 29)

Incoming call
The system detects an incoming call, the
phone rings.

Incoming calls are indicated in a window in
any system (e.g. radio).

<1 All »m

Call From
00331728362245
ri/ant [

Accept > m
| Back|

Ready

—=nl

P82.86-4081-31US

ST < Roet

Radio

FM9

The window shows:

e the caller’s number if it is transmitted
or

e the caller’s name if her or his name and
number are saved in the phone book.

%

Telephone*

Telephone operation

Accepting a call

>
or

>

Press B3

Press .

The window disappears and the display
will change to the call menu

(> page 102). An active audio source
will be muted. You talk over the hands-
free set.

Muting the ringing tone

>
or

>

Press Bl

Press I to highlight Reject and
than press @.

The window disappears. The last active
audio source is audible.
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Telephone*

Telephone operation

Setting the volume for hands-free ope-
ration

Sound settings e Redial (> page 99)

You can change the sound settings (only o
Balance) during a conversation.

Selecting an entry from the dialed

Raising the volume numbers list (> page 100)

» Turn the rotary control on the @ but-
ton to the right.

For more information, see chapter “At a .
glance” (> page 29).

Selecting an entry from the received
calls list (> page 101)

() Additional control functions are explained e Use speed-dialing (> page 102)

This function is possible during an at "Active Call” (> page 102). e Use quick-dialing (> page 102)
active call, otherwise volume of audio

o Selecting a phone book entry and
source, e.g. radio is changed.

dialing the number (> page 105)

Ending a call °

» Press B

After ending the call, the system stores

the current volume setting. If current
volume setting exceeds the default set-
ting, then the system will use the de-
fault level for next incoming/outgoing
call.

o (i)

No ring or DTMF tones will be heard
when a mobile phone set to silent mode
is inserted into the cradle. For ringtone

You can also make a phone call from
the address book (> page 187) and
using the Voice control system*. Refer
to separate Voice control system*

settings, refer to the separate opera-

. . . operating instructions.
ting instructions for the mobile phone.

Lowering the volume

Dialing a telephone number
» Turn the rotary control on the @ but-

Outgoing calls
ton to the left. S

You can use the following functions to Entering a telephone number

For more information, see chapter “At  make a phone call:

i » Open the Telephone menu
a glance” (> page 27).

e Dialing a telephone number (> page 96).

(> page 98)

%

ﬁ
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Telephone*

Telephone operation

» Use the number keys [Jili] - [Ell to enter Subsequent dialing

the telephone number. Calling...

Transmitting other dial tones:

i igits: 03088495213 .
Deleting the last or several digits: » During a call you can press the number

keys [l through K, and Il
o

If the system is downloading the phone
book at that time (e.g. after inserting
the mobile phone) these tones may be
transmitted with delay.

» Pressthe Delete soft key once or
several times.

Deleting all digits:

L4
» Press B TEL
P82.86-3983-31US

Ready
—=n[]

or
Dialing will begin. If a name is associa-

P hold the De1 ft key f
> Pressand hold the DeTete soft key for ted with the phone number saved in the

han 2 . i
more than 2 seconds phone book, the name appears on the ~ Redial
Bexgin dialin screen. In the status bar, the off-hook  p  |n the Telephone menu, press [EJ or
& g symbol will appear. @ twice.

>

When you have entered the telephone
number, press B2 to confirm your
input.

COMAND will mute an active audio
source. If the person called answers
the call, the call is active. You talk over

The telephone dials the number that
was dialed last.

or the hands-free set. (]

If you press B33 or @ just once, the
dialed numbers list is displayed

(> page 100).

» Inthe Telephone menu, press the Send
soft key.

or > Press B

> Press @. or
» Press the End soft key.

Ending a call

%




Telephone*

Telephone operation

Selecting an entry from the dialed Changing the list displa
numbers list 4 veed > WEE o o
A » Press the 123 soft key.
The COMAND automatically generates a EEERN 03088495213 The display changes to names
list of the last 10 numbers dialed. The list '
is sorted chronologically with the most or
recently dialed number at the top of the > Press the ABC soft key.
list. EX v | Back| .
Ready The display changes to numbers.

0 Unknown Name -=nl

Duplicate entries will be shown only PezsesRe3Ils — Selecting an entry and begin dialing

once. This means the list may contain | he status bar shows: » Use ¥ or K@ to select the desired

less than 10 entries. e the caller’'s name if her or his name and entry.

number are stored in the phone book
. . . » Press B
Displ. the list
ispraying the lis e the message Unknown Name if no entry )

» In the Telephone menu (> page 96), is available ©

press the Redial soft key. » Press .
or You can select the following functions: The telephone dials the number.
» In the Telephone menu (> page 96), * Changing the list display

press the Calls soft key. e Selecting an entry and begin dialing
» Press Y to display the dialed num- e Ending a call (> page 99)

bers list.

The most recently dialed number is
highlighted.

.

2

e 4|
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Selecting an entry from the received
calls list

The COMAND automatically generates a
list of the last 10 calls received. The list is
sorted chronologically with the most

recently received call at the top of the list.

o

Duplicate entries will be shown only
once. This means the list may contain
less than 10 entries.

Displaying the list

» In the Telephone menu (> page 96),
press the Calls soft key.

The list is displayed and the most
recently received number is
highlighted.

%

< Received Calls > m
5

I + 293088495217
Display

v

TEL

Ready
-ml[]

Unknown Name

P82.86-3985-31US
The status bar shows:

e the caller’s name if her or his name and
number are stored in the phone book

e themessage Unknown Name if no entry
is available

e the telephone number

Telephone*

Telephone operation

You can select the following functions:
e Changing list display (> page 100)

e Selecting an entry and begin dialing
(> page 100)

e Ending a call (> page 99)

Missed calls

If there are one or more missed calls avai-
lable on the mobile phone, a correspon-
ding message will appear.

» Pressthe Back soft key to return to the
Telephone menu.

or
» Press EEN
or

> Press @.




A\
/S

g%% 230_Telefon_US_B.fm Seite 102 Mittwoch, 8. Dezember 2004 4:32 16

Telephone*

Telephone operation

Speed-dialing > Press BN Active call
or
For all memory locations If the person f:alled or you answer a .caII,
> Press @. the call is active. The call indication is
At the mobile phone you can save ) displayed.
telephone numbers in the speed-dialing The telephone dials the saved number.
memory and use them. Refer to the mobile  Enging a call (> page 99) [ Mic Off | Call Connected: m
phone operator’s manual.
o . s s Bohne Julia m
You can also use speed-dialing at the Quick-dialing 07124776951
COMAND (only mobile phone memor ; iali B
only P y Quick dialing can be used on memory loca-
locations 1-999). tions 1-9.
You can enter up to 3 digits. » Open the Telephone menu
» Open the Telephone menu (> page 96). TEL 00:23:00 =
(> page 96). » Press one of the number keys [Jilil - P82.86-4082-31US
Memory locations with up to two digits: longer than 2 seconds. Call menu
» Use the number keys [Jij to FEM to The telephone dials the saved number. oy talk over the hands-free set. You can
enter the memory location number. Ending a call (> page 99) setting the volume for the hands-free

Memory locations with three digits: operation (> page 97).

» Use the number keys [Jij to to
enter the memory location number
followed by the key.

The status bar indicates the call time.

%
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% Telephone*

Telephone operation

The following functions can be used during  Ending an active call » Pressthe Mic Off soft key.

a call: » Press B The microphone is switched on or off.

e Ending an active call The Telephone menu will appear The soft key status changes
e Switch on/off hands-free microphone accordingly.
« Change sound settings (Balance only), SW|tch|.ng har.lds—.free mlcro.phon.e on/ When the microphone is off, the o.ther
(> page 98) off (available if microphone is switched party cannot hear you. You can still
on) hear your partner.

e Transmitting other dial tones
(> page 99)

o

You can use three-way calling if this

The microphone status is indicated by the
status of the Mic Off soft key.

Microphone Symbol

feature is offered by your mobile phone D) Mic Off
service provider. On white
Refer to the mobile phone operator’s Off black

manual or contact your mobile phone
service provider for feature availability
and operating instructions.

o -




Telephone*

Telephone operation

Phone book
The phone book contains all entries

e of the internal memory of the mobile
phone (TDMA/CDMA and GSM mobile
phone)

(i
GSM mobile phone:

COMAND also reads entries from SIM
card.

e of the address book (> page 176) if it
contains any telephone numbers
Displaying the phone book

» In the Telephone menu (> page 96),
press the € soft key.

The phone book will appear.
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| D >
A
¢ Dexter, Paul
B Dexter, Paul
eh Dexter, Paul

Page A
Display Page ¥

Delete

v Back

01808122002

P82.86-3992-31US

The first entry found is at the top of the list
and highlighted.

Phone book
entry

Status bar shows

A phone number Unknown Name

A name for a
phone number

The phone number

Several numbers Several Numbers

e

All entries are marked with symbols which
indicate the phone number category.

Entries marked with symbols have been
imported into the phone book from the in-
ternal memory of the mobile phone.

Usable phone number categories:
e Symbol g: Cell number

e Symbol @: Private number

e Symbol gi: Business number
And additional categories:

e Symbol B9: Fax number

e Symbol &: Pager number

e Symbol €@: Main number

e Symbol @7: E-mail address

o

Address book entries with more than
one phone number are marked with the
Main number €@ symbol.

.

2

ol
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You can select the following functions:

Changing the phone book display at
the COMAND

Selecting a phone book entry and
dialing the number (> page 105)

Entering and saving a new phone book
entry* (> page 106)

Deleting a phone book entry
(> page 108)

Changing the phone book display

>
>

or

Open the phone book (> page 104).
Press the 123 soft key.

The display changes to numbers. The
status bar displays the name of the
marked entry.

Press the ABC soft key.

The display changes to names. The
status bar displays the number of the
marked entry.

Selecting a phone book entry and
dialing the number

>

Open the phone book (> page 104).

The list of phone book entries with
names starting with a certain letter is
displayed.

Changing the initial letters

with Kl and I

>

Press Kl or [ one or several times.

With every push of the button the
display changes to the next possible
letter. At the end of the letter list
follows the category Other.

Category Other:

Here, all entries without names or with
names starting with a special character
(e.g. * or #) are put together.

o

If you hold one of the buttons, scrolling
is accelerated.

%

Telephone*

Telephone operation

With the number keys

The number keys are labelled with the let-
ters which can be selected.

>

Press, e.g. A

The system displays a window above
the status bar which shows the letters
G, Hand I. After that, the address book
list with the letter G is displayed.

To select, e.g. the letter H, press
twice in quick succession.

Selecting an entry

>
>

Change the initial letter if required.
Use [K or [N to select a list entry.

o

If you hold one of the buttons, scrolling
is accelerated.
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Telephone*

Telephone operation

Begin dialing New phone book entry Cell Phone:
> Press B2 You can create new phone book entries as The new entry is sa\{ed in the internal
: memory of the mobile phone.
or entries
. . . Address Book:
e inthe internal memory of the mobile
> Press @. phone y The new entry is saved in the address
If the selected entry is an address book book.
or
entry (several phone numbers): » Use [ or K@ to select Cel1 Phone
» Use |I¥ or K& to select Cel1, * inthe address book. or Address Book.
Work or Home. » Press the New soft key in the phone > Press @.
If the selected entry is a cell phone book. Cell Phone:
entry (several phone numbers): A selection menu appears. An input menu (> page 107) appears.
» Use [N or B4 to select one of the Address Book:
phone number categories, NeWAEntry A selection menu appears.
e.g. @ (> page 104). Cell Phone
Address Book Store Number As
» Press B2 A
or Cell
Work
> Press @. v | Back| Home
The telephone dials the number. TEL il

P82.86-3993-31US W

Ready

TEL -=n([]

P82.86-2847-31US

- —+|®
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Telephone*

Telephone operation

» Use [N or B8 to select Home, Cel1 or  Entering a surname, name or number » Enter the data using the selection
Work. » Use [N or B4 to select the name or menu (> page 193).
» Press @. the number field. After input using the selection menu,
An input menu appears. You can input data: the input menu is dlsplayfed again. You
can select the next data field and enter
e using the selection menu
New Entry [ oK J data.
L | A * via the number keys [l - [ Input via the number keys [l - Il
urname: . .
Name: Using the selection menu: » Use buttons [l - Il to enter the data
gD » Press the Keypad soft key. (> page 195).

ﬂ The selection menu appears.

TEL joial New Entry [ ok
A

P82.86-3994-31US
Name: MDD |
Input menu v

ABCDEFGHIJ 123

KLMNOPQRST - 45 ¢ X
UVWXYZAOUBR 789

17, + - fabe) o (ok) [IEER
o TEL Zann
If you have select the Ce11 Phone T
entry, the input menu displays the . ‘
surname and number field. Selection menu

The Surname field is automatically
marked.

%




Telephone*

Telephone operation

Saving the entry

>

In the Input menu, press the 0K soft
key.

If you have not assigned a name, the
system will save the entry inthe Other
category, otherwise under the name
you have assigned.

Cell Phone

The message Transmitting Data
to Telephone is displayed.

If transmission is succesful, the
message Data Has Been Saved will
appear and the phone book is
displayed again.

Otherwise the message Error
Occured While Saving Data will
appear.

» Press @ to confirm.

The phone book is displayed again.
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Address Book

If transmission is succesful, the
message Data Has Been Saved will
appear and the phone book is
displayed again.

Otherwise the message Error
Occured While Saving Data will
appear.

» Press @ to confirm.

The phone book is displayed again.

Deleting a phone book entry

» Select a phone book entry at the
COMAND (> page 104).

o

If you select an address book entry, the
Delete soft key is greyed out. The
selected entry must be deleted from
within the address book (> page 186).

» Press the Delete soft key.
The delete dialogue will appear.
» Press @ to confirm with Yes.
The message is deleted.
If you do not wish to delete the message

» Press i to highlight No and then
press .
or

» Press the Back soft key.

@%

2
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Telephone*

Telephone operation

Saving a phone book entry on the tele- Saving phone numbers JRg—

hone
P You can save phone numbers A
» Use button Y or K to select a pho- ) i ) Cell Phone
ne book entry. o |nhthe internal memory of the mobile Address Book
phone

» Press the Save softkey. in the address book

(i) » Open one of the lists: —
-

If you select a phone book entry from « Dialed numbers list (> page 100) +499417908000 B a0l

the internal memory, the Save soft key P82.86-3996-31US

is greyed out. e Received calls list (> page 101)

Saving a single phone number on the

i » Use or to select an entry.
If a phone book entry contains several N K2 y telephone

numbers (address book entry), they are P h ftk
transferred together. > Press the Save softkey. » Press @ to confirm Ce11 Phone.

A selection menu appears. . .
PP Aninput menu will appear. The Number

The message Transmitting Data field contains the phone number to be
to Telephone will appear. saved.

If transmission is succesful, the mes-

sage Data Has Been Saved will ap-

pear.

o -
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Telephone*

Telephone operation

Enter Name
A
Surname: A|
Number: 01808122002

v

Ready
TEL —=n([]
P82.86-3997-31US
» Enter a name in the Surname field:
You can input data:

e using the selection menu by
pressing the Keypad soft key
(> page 193)

e via the number keys -
(> page 195)

g%% 230_Telefon_US_B.fm Seite 110 Mittwoch, 8. Dezember 2004 4:32 16

Finishing data input and saving the phone
number:

Input via selection menu:

» Press the OK soft key.
Input via 12-button keypad:
> Press @.

The message Transmitting Data
to Telephone is displayed.

If the transfer was successful, the mes-
sage Data Has Been Saved will ap-

pear and the list is displayed again.

Otherwise the message Error
Occured While Saving Data will
appear.

» Press @ to confirm.

The list is displayed again.

Saving in the address book

» In the selection menu (> page 109),
use |§d to select Address book.

» Press @.
A selection menu will appear.
Save Number
A

New Entry
Addition

v

Ready

+499417908000

P82.86-3998-31US

Saving as a new entry
> Press @ to confirm New Entry.

Another selection menu will appear.

e alh
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Telephone*

Telephone operation

Adding to an existing entry

Store Number As Enter Name m

A A » In the selection menu (> page 110),
Cell Surname: A| use [§@ to select Addition.
Work Name:
Home Number: +499417908... » Press @.

Del i
The phone book will appear.
. | Back]

Ready <4 D | 2
+499417908000 TEL = Tall A
P82.86-3999-31US P82.86-4000-31US m ¢ Dexter, Paul
Use I or K@ to select the phone You can input data: § Dexter, Paul
> “ n P > P eh Dexter, Paul

number type. e using the selection menu by

» Press @. E)Dreszlgneg {cgg)Keypad soft key < m
An input menu will appear. - e = ==

o via the number keys [l - I
(> page 195)

P82.86-4001-31US

» Select the phone book entry
(> page 105).

» Press @.

A selection menu will appear.

Finishing data input and saving:
> Press @ or the OK soft key.

If the transfer was successful, the
message Data Has Been Saved will
appear and the list is displayed again.

%
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Telephone*

Telephone operation

Phone number type occupied:
Store Number As P P 0

A The message Do You Want to Over- If transmission is not succesful the

\(l:\/e”k write Entry? will appear. message Error Occured While
or . .
Home » Press @ if you wish to overwrite the Saving Data will appear.
entry. » Press @ to confirm.
\v4 The message Data Has Been Saved The phone book is displayed again.
Ready will appear. After around three se-

TEL 01729876543 -un0l]

P82.86-4002-31US

» Use [ or [E4 to select the phone
number type.

» Press .

Phone number type available:

conds, the list from where you started
the saving process will appear.

If you do not wish to overwrite the entry

» Press i to highlight No if you do not
wish to overwrite the entry.

» Press .

The list from where you started the sto-
rage will appear.

The message Data Has Been Saved
will appear. After around three se-
conds, the list from where you started
the saving process will appear.




e,
AU 230_Navigati US_B.fm Seite 113 Mittwoch, 8. Dezember 2004 4:37 16

t

Navigation

Important notes

Navigation main menu

Destination input

Route guidance

During route guidance

Last destinations and destination memory
POls

Software updates
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Navigation

Important notes
V Important notes

A

Warning

For safety reasons, you should only enter a
destination when the vehicle is stationary.
When the vehicle is in motion, a passenger
should enter the destination. Study manual
and select route before driving.

Do not watch display screen or operate but-
tons while the vehicle is in motion - let voice
instructions guide you. Stop at a safe locati-
on before using buttons or making correc-
tions.

Traffic regulations always have priority over
any route recommendations given.

Bear in mind that at a speed of just 30 mph
(approximately 50 km/h), your car is co-
vering a distance of 44 feet (approximately
14 m) every second.

The route calculated by COMAND is a re-
commendation on how to best reach your
selected destination.

During route guidance, you will not receive
any information on

e Traffic lights

e Stop and yield signs

e Parking or stopping zones

e One-way streets

e Narrow bridges

e Similar traffic regulation data

You should therefore always strictly observe
traffic regulations while driving. Drive care-
fully and always obey traffic laws and road
signs even if they contradict COMAND in-
structions.

A\

Warning

e

The Navigation DVD module contains a
Class 1 laser product. There is a danger of
invisible laser radiation if the cover is ope-
ned or damaged.

Do not remove the cover. The Navigation
DVD module does not contain any parts ser-
viceable by the user. For safety reasons,
have any necessary service work performed
only by qualified personnel.

ﬁ
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Navigation DVD

COMAND calculates the route with the
help of data that is stored on the navigati-
on DVD.

Only use Mercedes-Benz navigation DVDs.
Using other navigation DVDs or CDs will
cause malfunctions and/or damage.

Because of changes in local traffic patterns
(e.g. road works) and/or incomplete data,
errors in calculation may occur.

As a result, the recommended route may
deviate from the ideal route. The data
stored on the DVD only reflects local con-
ditions at the time of DVD production. DVD
maps do not cover all areas nor all routes
within an area.

o

The message No DVD Available
Please Insert Navigation DVD
will appear if no DVD is currently
loaded in the navigation computer.
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GPS (Global Positioning System) sig-
nals received make it possible to deter-
mine the current vehicle position.

Deviations from the actual position
may occur

e if the reception of GPS signals is
disturbed e.g. in parking garages
and tunnels

e if road conditions are bad

e depending on the vehicle’s conditi-
on

Loading/ejecting a DVD

DVDs are loaded and ejected at the
navigation computer. The navigation
computer is located on the left side in the
trunk.

Open panel cover to get access to the
navigation computer.

%

Navigation

Important notes

e _‘\9_2
0 CAR NAVIGATION DVD

P82.86-2967-31US

(D) Ejecting DVDs
(@ DVD slot

Ejecting
> Press |IEX

The navigation computer ejects the
DVD.

o

If you do not remove the DVD from
the slot within around 15 seconds, the
COMAND will pull the DVD into the
drive.
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% Navigation %

Important notes

Loading Determining the location after the Drive until the position or the road
> Insert the DVD into the DVD slot & vehicle has been transported indicated correspond to the real

with the label side up. The system will need some time to cwcumstanc'es. The system is now
determine its location after the car has correctly adjusted.

been transported. The time required for
the system to do so varies from case to

The navigation computer pulls the DVD
in.

Route guidance after the vehicle has case.

been transported » Switch the COMAND on.
If your vehicle has been transported (e.g.
by a car, train or ferry) the system may
make navigation announcements which do

» Activate the Navigation main menu
(> page 118).

not correspond to the vehicle’s position. The navigation DVD needs to be inthe  pusmrs
The system needs to redetermine its navigation computer (> page 115). —
> P82.86-2854-31US
position. » Drive and press &
The display will change to the map
display.

o
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Trip interruption during route
guidance

o

Trip interruption means the vehicle is
parked and COMAND is switched off.

Trip continuation means the vehicle is
moving and COMAND is switched on
again.

The following applies if you interrupt your
trip and continue later on:

Trip is continued within 2 hours:

The system will automatically resume
route guidance.

Trip is continued after more than
2 hours:

> Press @ to confirm Continue
Route Guidance inthe
Navigation main menu
(> page 118).

Navigation

Important notes




Navigation main menu

Navigation

V Navigation main menu

Activating the Navigation main

menu

» Press [

The Navigation main menu will appear.

o

If a navigation submenu is displayed,
you need to press the button twice.

A
m Destination Memory
Destination Entry
Last Destinations
POls
[ Mode |

v

NAV

P82.86-2850-31US

o

If route guidance is active, a message
appears instead asking you whether
you wish to resume route guidance
(> page 143).

If route guidance has been interrupted
for more than 2 hours, the entry
Continue Route Guidance will be
on top of the list.

Use K4 or Y to select a menu item.

Press .

Press one of the soft keys. Available
soft keys (> page 119).

The selected menu or the function of
the selected soft key appears.

Selectable Menu Items

Continue Route Guidance:
Resumes interrupted or aborted route
guidance.

This menu item appears if you:

¢ have aborted route guidance
(> page 143) and less than 30
minutes have elapsed since the
guidance process was aborted

e have interrupted your journey and

e

continue it after more than 2 hours

ﬁ
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¢

Destination Memory
You can select destinations from the
Destination Memory (> page 158).

Destination Entry
Activates the Destination Entry
menu (> page 124).

Last Destinations

You can select last destinations from
the Last Destinations memory
(> page 155).

POIs:

Brings you to the POIs input menu
(> page 160).

POls are e.g. gas stations, parking
facilities or airports.

Available soft keys

Home soft key:
You can edit the home address and
start route guidance (> page 138).

Mode soft key:

Brings you to the route mode setting
for the next route guidance

(> page 120).

Setting soft key:

Here, you can make audio settings for
the navigation announcements (treble,
bass, balance) (> page 121)

Navigation

Navigation main menu
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Navigation

Navigation main menu

Setting the route mode

The COMAND calculates the route as
Fastest route.

Including or avoiding traffic routes

» In the Navigation main menu
(> page 118), press the
Mode soft key.

The Mode menu will appear.

Minimize
A
Minimize Freeways
Min. Ferry/Auto-Train
Minimize Toll Roads
Minimize Tunnels

oooo

v

NAV Mode

P82.86-4051-31US

Selectable traffic routes

Minimize Freeways:
The system calculates the route with/
without minimizing freeways.

Min. Ferry/Auto-Train:

The system calculates the route with/
without minimizing ferry connections
or railfreight.

Minimize Toll Roads:
The system calculates the route with/
without minimizing toll roads.

Minimize Tunnels:
The system calculates the route with/
without minimizing tunnels.

Option Symbol
On (]
Off [

e

Use [N or B to select a traffic route.

Press @.

Switches the option on or off. You can
switch on more than one option.

Press the Back soft key to confirm.

The setting is saved. The Navigation
main menu will appear.

ﬁ
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Audio settings for the navigation
announcements

You can set the following for the navigation
announcements:

e Bass and treble control (> page 121)
e Balance (> page 121)
e Volume (> page 122)

» In the Navigation main menu
(> page 118), press the Setting soft
key.

The Settings menu will appear.
The announcement Navigation Is
Not Active is made.

%
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Adjusting bass and treble

» In the Settings menu, press the Bass
or Treble soft key.

> Press Kl or I
You adjust bass or treble.
> Press @ or the Back soft key.
or
» Wait until the display changes.

The new setting is saved. The
Navigation main menu appears.

e

Navigation

Navigation main menu

Adjusting balance

» In the Settings menu, press the
Balance soft key.

Cross-hairs are displayed. The vertical
line indicates the fader setting. The
horizontal line indicates the balance
setting.

o

Balance defines the sound center left/
right.

> Press Kl or &

Move the cross-hairs horizontally and
adjust the balance.
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Navigation

Navigation main menu

> Press @ or the Back soft key. Reduction for Audio-Vol. Saving current position

or A
» Press m

> Wait until the displ h No reduction @)
ait until the display changes. i i i
play 8 m::;::rl;‘e(::glt;;ri\on 8 Thﬁ full \t/LeW O;'thle,map apptears..t\'(ou
ing i will see the vehicle’s current position.
The.neV\'/ settm'g is saved: The MSior idiluction " Nawvol, p
Navigation main menu will appear. Maximum reduction O o
v |_Back L
Adjusting the volume . If a map submenu is dlsplay.ed, you
NAV Settings need to press the button twice.
The automatic navigation announcements P82.86-2800-31US
override thg currently active .audlo source. ), yse |kl or M to select an option. > Press any soft key.
You can adjust the volume difference. The ) )
setting will reduce the volume of the > Press @. The soft key displays will appear.
currently active audio source for the » Wait until the Settings menu is
duration of the announcement. displayed again or press the Back soft
» Inthe Navigation main menu, press the key.
Setting soft key. The new setting is saved. The
The Settings menu will appear. Navigation main menu will appear.
» In the Settings menu, press the
Nav.Vol. soft key.
NEWPORT RD
Options for the reduction of audio P82.86.410131US

volume are displayed.

g///




» Press the Memory soft key.

A window appears with the
message Position Saved as
MemPt.

The system saves the current position
as a destination in the Last
Destinations memory

(> page 155).
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o

Such destinations are marked in
the Last Destinations memory
with @.

For permanent storage you can save
the destination in the regular
Destination memory (> page 156).

You can save up to 20 such
destinations.

e

Navigation

Navigation main menu
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Navigation

Destination input
V Destination input

Activating the Destination Entry > Press @. Selecting the region
menu Either of the following appears: 0
» Activating the Navigation main menu e the Select Region list, if no You can also select a region by
(> page 118). destination has been entered pressing the Region soft key in the
previously Destination Entry menu.
A

Destination Memory e the Destination Entry menu )
B iMion Entry (> page 125) » Press ¥ or K4 to select a region.
Last Destinations > Press @.

POls A
CANADA If not more than 12 destinations are

m v HAWAII Page A available for the selected region, you
USA can now select the destination

Page ¥
NAV (> page 127).
P82.86-2850-31US If more than 12 destinations are
» Press |4 or K& to select the menu v BC available, the main Destination Entry
item Destination Entry. NAV Select Region menu appears.
P82.86-2855-31US If you have selected another region, the
Select Region list destination last input is deleted. The

destination in the region which comes
first in the alphabet is displayed.

e
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A
N

Navigation

i

Destination input

Entering destination address » You can now accept the destination e CityCtr soft key:
shown (> page 126) or enter another Brings you to the district (center)

If destinations have been entered already, .
y (> page 126). selection (> page 128).

the Destination Entry menu will appear.
Available soft keys: e POIs soft key:

Entering Points of Interest

(> page 160).

«a NEW YORK CITY, NY e Map soft key:

Brings you to the destination input
m directly above the map (> page 135). ()
ABCDEFGHI ) 123 . )
KLMNOPQRST 45(> e Region soft key: If you press the Street, CityCtr or
WXYZ->., 789 Brings you to the region selection POIs soft key, the soft key function
m & o fox) IIEE (> page 124). refers to the place indicated.
NAV Enter City (USA) 0
P82.86-2856-31US ¢ L-l St SOft key:
o The currently set region is identifed by Brings you to a list of streets beginning

Destination Entry menu the region code in the status bar. with the previously input letters.
The most recently entered destination is e Delete soft kev:
shown in the upper area. e Street soft key: v

Brings you to the destination road input The character last entered or the

(> page 129). character last accepted by the system

is deleted.

e Back soft key:
Returns you to the previous menu.

o e
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Navigation

Destination input

Accepting the displayed destination

>

or

In the Destination Entry menu, press
@ longer than 2 seconds.

You will hear a confirmation beep if the
beep tones option was activated in the
system settings (> page 201).

Select the symbol in the
Destination Entry menu. Press K,

B2 N B2 to do so.
Press @.

Entering another destination address

>

or

Press |1, IKN, I and K4 to select

the characters. After each selection,
press .

Press |4 and |l to select characters
diagonally.

Press one of the number keys to
as often as needed.

A window will appear at the bottom of
the menu showing the available
characters.

o

You can only select admissible
characters. The character selected
appears magnified. If your input is
unambiguous, the system will
complete it.

e

(i

For quicker input, COMAND offers
available characters from the character
set based on your selections and the
names of the cities stored on the
navigation DVD. The character
selected appears magnified. The
system will accept the entry if the input
matches the name of a city stored on
the navigation DVD.

Press the Delete soft key if
necessary.

The character last entered or the
character last accepted by the system
is deleted.

ﬁ
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Navigation

Destination input

o i ] o

Do not confuse the Delete soft key In some cases, the system may Pressing the Back soft key will abort
(deletion of the last character) with the distinguish cities of the same name by the selection process.
Back soft key (deletion of the complete area selection (> page 128).
entry). > Press @.
Selecting a city
» Press @ longer than 2 seconds to (i ]
confirm. A If several options of a city are available,
You will hear a confirmation beep if the “Ew ¥g§§ :\:llllTL{’sNI/IN palge A another menu will appear where you
: . : ) must make and confirm your desired
beep tones option was activated in the NEW YORK MILLS, NY )
system settings (> page 201). NEWALLA, OK Page V selection.
NEWARK, AR
or NEWARK, CA After you have selected a city one of
» Select the symbol in the v m the following menus will appear:
Destination Entry menu. Press n, NAV Select City e For |arger cities with more than 15
I3 ¥ K2 to do so. P82.86-2858-31US streets: Enter Street input menu
> Press . > Use I or B4 to select the desired (> page 129).
The city list will appear. You can now city. * For smaller cities with up to 15
accept the city entered or select streets: Select Street menu
another. (> page 130)

e If no streets are available for the
selected city, or if a street extends
through several city centers:
Select CityCtr menu (> page 128)

- —$- —el®
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Navigation

Destination input

Selecting the area of the destination Selecting a city center In addition to the center selection you can
use the following soft keys to determine

Towns of the same name are distinguished  After you have entered the city, you can o
your destination:

by the area in which they are located. After  select a center (district).

you have entered the place, .a |I-St of areas > Press the CityCtr soft key. o Ma.p soft key: S
may appear. The status bar indicates the Brings you to the destination input
number of areas available, for example: m;"‘ NEW YORK GITY, NY m directly above the map (> page 135).
Town found [number]. A e POIs soft key:

Page A R o
» Press K4 or ¥ to select an area. ﬁg}lgguE’NNYY Entering Points of Interest
> Press @. BAYSIDE,’ NY (> page 160).

BELLEROSE, NY
» You can now enter a street BREEZY POINT, NY
(> page 129). EI v | Back|
NAV Select CityCtr

P82.86-2862-31US

» Press [y or B to select a center.
» Press .

The Route Guidance menu will appear
(> page 139).

A2
AN
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Entering a street

The system will display one of the following

menus after you have entered the city:

e |n the case of cities with more than 15

streets: Enter Street menu
(> page 129).

¢ In the case of cities with up to 15
streets: Select Street menu
(> page 130)

e If no streets are available for the
destination: Select CityCtr list
(> page 128)

The respective menu is indicated on the
status bar.

In addition to the street selection, you can

use the following soft keys to determine
your destination:

e Map soft key:
Brings you to the destination input
directly above the map (> page 135).

e CityCtr soft key:
Brings you to the district (center)
selection (I> page 128).

—
Fois
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POTs soft key:
Brings you to the Points of Interest
selection menu (> page 160).

A BROADWAY
«a NEW YORK CITY, NY

Gl  Back|

NAV Enter Street

>

or

>

P82.86-2863-31US

Press I, IKI I and [E4 to select

the characters. After each selection,
press @.

Press ] and |l to select characters
diagonally.

Press one of the number keys to
as often as needed.

%

Navigation

Destination input

(i

For quicker input, COMAND offers
available characters from the character
set based on your selections and the
names of the streets stored on the
navigation DVD. The character
selected appears magnified. The
system will accept the entry if the input
matches the name of a street stored on
the navigation DVD.

Press the Delete soft key if
necessary.

The character last entered or the
character last accepted by the system
is deleted.

o

Do not confuse the Delete soft key
(deletion of the last character) with the
Back soft key (deletion of the complete
entry).

ﬁ
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Navigation

Destination input

» Press @ longer than 2 seconds to Selecting a street
confirr? ° d m
A BROADWAY
You will hear a confirmation beep if the JRlEW YORE GinG A m m-m NEW YORK CITY, NY
beep tones option was activated in the BROADWAY [Hse No. |
system settings (> page 201).

Y B (- pege 201 e Mode | [_savel
or BROADWAY TER m [Start Route Guidance| W
» Select the symbol in the Entry BROADWAYxV -

menu. Press |KlI, I, N, B4 to do
s0. NAV Select Street P62.86-2865-31U8
> Press @. pa2ssassasius  1he following soft keys are available to

further define your destination:

L » Use Y or K4 to select a street.
The street list will appear. You can now e Map soft key:
» Press @&. :
select a street. o Brings you to the destination input
o The menu for Startlng the route direcﬂy above the map (|> page 135)
guidance function with the destination

data you have entered is displayed. Intrsct. softkey:

If several options of streets are availab-

le, another menu will appear where you You can select an intersection for the
must make and confirm your desired destination street (> page 131).
selection. e Hse No. soft key:

Brings you to the destination street
house number input (> page 132).

7

e
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o

You can select either an intersection or
the house number. You cannot enter
both.

e Mode soft key:
Brings you to the Change mode
selection menu (> page 120).

e POIs soft key:
Brings you to the Points of Interest
(POI) menu (> page 161).

e Parking soft key:
Brings you to the menu for inputting a
parking near the destination street
(> page 134).

e Save soft key:
You can enter your destination into the
Destination memory (> page 156).
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Entering an intersection

After you have entered a destination street
(> page 129) you can select an
intersection to that street.

ap |

A BROADWAY

EZ=M.. NEw YORK CITY, NY

m [Start Route Guidance]

A\

P82.86-2865-31US

» Pressthe Intrsct. soft key.

o

The Intrsct. soft key is only
available if appropriate streets are
saved on the navigation DVD.

Navigation

Destination input

The system will display one of the following
menus:

e |n the case of streets with more than
15 intersections: Enter Intersection
menu.

4 ACADEMY ST
A BROADWAY
«a NEW YORK CITY, NY

ABCDEFGHI ) 123

LMN P RST 456 JNES
Uvw 789
[ok]

NAV Enter Intersection
P82.86-2866-31US
» Enter the name as specified in

“Entering a street” (> page 129).
» Pressthe List soft key.

The Select Intersection menu will
appear. It displays a list of roads
intersecting with the previously input
intersection.

» Select an intersection (> page 132).

ﬁ
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Navigation

Destination input

¢ In the case of streets with up to 15

intersections: Select Intersection m B

A BROADWAY A BROADWAY
menu B2 .. NEW YORK CITY, NY sa NEW YORK CITY, NY
» Press ¥ or K& to select an Hse No. | .
prseton e =D 43 mm

789

> Press @. m [Start Route Guidance| ﬂ

The Start Route Guidance menu will

NAV NAV Enter House No.
appear (> page 139).
P82.86-2865-31US P82.86-2867-31US
Entering a house number » Pressthe Hse No. soft key. » Press [, KKl M and KA to select
. . the numbers. After each selection,
A house number can be entered after Either the menu for entering a house ress @
entering the destination street number or a list of house numbers to P :
(> page 129). select from will appear (> page 133).  » Press ¥ and [l to select numbers
o diagonally.
0 . o . . or
You can enter an intersection instead The Hse No. soft key is only available '
of the house number. You cannot enter if appropriate streets are stored onthe > Press the appropriate number keys
both. navigation DVD. B Bt

7
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Navigation

Destination input

() Selecting a House Number Area > Press @.
You can only select admissible i The Start Route Guidance menu will
numbers. The number selected A BRCZ\DWAY appear (> page 139).
appears magnified. 1
2.8 Entering a parking

Press the Delete soft key if 10..12 . N
necessar 13..27 After entering the destination street

y: 14..28 (> page 129) or selecting a city center
The number last entered is deleted. v m (> page 128), you can select parking
0 NAV Select House No. nearby.
Do not confuse the Delete soft key Pez Bo-2808-3108 [ Parking |

. m- g

(deletion of the last character) with the ~ » Press 4 or [Kd to select the desired A AVENUE OF THE AM.
Back soft key (deletion of the complete house number area. EE2 .. NEW YORK CITY, NY

entry). Py [Fse No-
House numbers may be displayed in m

the list as single numbers, e.g. 1, oras  [[OEll [Start Route Guidance] [IEEEd

) ) ) ) number areas, e.g. 2. . 8.
You will hear a confirmation beep if the NAV

beep tones option was activated in the P82.86-2965-31US
system settings (> page 201).

Press @ longer than 2 seconds to
confirm.

The Start Route Guidance menu

(> page 139) or a list for selecting a
house number or a house number area
will appear.

o e
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% Navigation

Destination input

Press the Details soft key to see
more information about the parking lot.

Press @.

Route guidance will begin.

» Press the Parking soft key.

The Parking Lot Selection menu is
displayed.

o

If there is no parking lot near
the destination, the message No

Parking Found will appear. PACE PARKING (PG) 500 ft
P82.86-4010-31US

Selecting a parking lot
» Use the Next or Prev. soft key to

The map is displayed and shows the select a parking lot on the map.

destination and the available parkings lots.
The parking lot selected is marked in

color. The name and distance from the
current position are shown on the
status bar.

%%‘@%
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Selecting a destination using the map

» Press [

The map view set via the DispTay soft
key will appear, e.g. bird’s eye view
(> page 153).

» If you press one of the buttons |,

3 I E2. BN & the cross-hairs

appear.
or

» Press the Map soft key, e.g. in the
Destination Entry menu (> page 125).

The map is shown in full view and
cross-hairs appear.

o

The system automatically places the
cross-hairs on the current destination
address.

%

NEWPORT RD

P82.86-4011-31US

If soft key displays are hidden:
» Press any soft key.
The soft key displays will appear.

o

was pressed:

If no soft key is selected within approx.

8 seconds, the soft key display will
disappear again.

Navigation

Destination input

Available soft keys

Coord. soft key:
Brings you to the destination
coordinates input (> page 137)

POIs soft key:

Brings you to the Points of Interest
(POI) menu (> page 161).

Memory soft key (if Il was pressed):
A window appears with the

message Position Saved as
MemPt. (>> page 122).

Display soft key (if Y was
pressed):

The Map View display will appear.
You can adjust the map orientation
(> page 153).

Soft key &:
Zooming in for more detailed map.

Soft key &:
Zooming out for less detailed map.

Back soft key (if was pressed):
Returns you to the previous menu.

ﬁ
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Navigation

.

Destination input

» Press KL I N B2 BN to  This allows you to select your destination. (5 )

move the cross-hairs. » Release the button. If you press the Back soft key, your

selection will be discarded. The system
then uses the data of the previous

The direction of movement of the

If the system is able to assign a street
buttons depends on the map direction y &

name to the selected location, it is

selected (> page 153). displayed on the status bar. destination.
e 2D North Up, 2D Heading Up: In this example: NEWPORT RD
Press and to move the » Press .

cross-hairs diagonally. The system uses the point at the center

e Bird’s-Eye View: of the cross-hairs as destination.
Use Kl and [ to turn the map Route guidance will begin.
round the vertical axis of the cross-
hairs.

Press [y or [E@ to move your
position on the map forward or
backward.

.

A2
>
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A
N

Navigation

t

Destination input

Selecting a destination using coordi- > Use ¥ or Kl to select one of the (5 )

nates items degree, minute or second. Change-over between NORTH and

» With either the map type (> page 135) » Press [I¥ or K4 SOUTH (latitude) and between EAST
or (> page 144) displayed, press the and WEST (longitude) is effected auto-

Depending on the selection, set the ) : A |
Coord. soft key. matically in accordance with the input.

desired value.

> Press @.
A The setting is saved. The map with the
NORTH  42° 42° 52,5" cross-hairs is displayed. The cross
< > hairs are positioned on the previously
WEST 74° 00° 25,3" input coordinates.
v | Back TR
NAV Coord. Entry The values which can be set for latitude
PB2.86-4048-31US (NORTH, SOUTH) and longitude (EAST,

WEST) are dependent on the map data

The Coord.Entry menu will appear.
available on the DVD.

The menu displays either

e the coordinates of the current ve-
hicle position

or

e the position of the cross-hairs on
the map.

o e
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Navigation

Destination input

Selecting home address Editing home address e selecting a destination from the last

destinations memory (> page 155
» Activate the Navigation main menu » Pressthe Change soft key. y (> pag )
(> page 118). selecting a Point of Interest

The Change Home Addr. menu will (> page 162)

» Press the Home soft key. appear.

. choosing the current position
The home address is shown. X

Destination Memory » Press [ or K4 to select an option.
Destination Entry » Press @
A 224 EAST CAPITOL ST Last Destinations
«u WASHINGTON, DC POls » Select the address.
(BAY AREA) Current Position >

Press @ when the Save as home

v address menu will appear.
[Start Route Guidance] A LAY Change Home Addr. The new home address is shown.

NAV P82:86-290331US  p Start route guidance (> page 139).
You can use the following functions

P82.86-2898-31US

» Start route guidance (> page 139). e selecting a destination from the
destination memory (> page 158)

e entering destination address
(> page 125)

7
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V Route guidance

Starting route guidance

Route guidance can be started if the
destination input is complete and Start
Route Guidance is displayed at the bottom
of the main area.

259
EE=M A sroaDWAY
mu NEW YORK CITY, NY
m [Start Route Guidance]

ek

NAV
P82.86-2869-31US
» Press .
Route calculation and route guidance
begins.

ﬁ%

Route calculation

Route calculation can take some time,
depending on the distance to the
destination.

During route calculation, CALC RTE and an
arrow pointing towards the destination are
displayed.

Route guidance begins when route
calculation is complete.

Recalculating an existing route
The system will calculate a new route
during active route guidance if the driver
does not follow the route guidance.

NEW RTE is displayed during recalculation.
The arrow is not filled out.

e

Navigation

Route guidance

Voice instructions

A\

Voice instructions are intended to direct you
while driving without diverting your attenti-
on from the road and driving.

Warning

Always use this feature instead of consulting
the map display for directions. Consulting
the map displays for directions may cause
you to divert your attention from driving and
increase the risk of an accident.

After route calculation, the system assists
route guidance using pictorial displays
(> page 140) and voice instructions.

Repeating current voice instructions

If you have not understood a navigation
announcement, you can at any time have a
current announcement repeated.

> Press B2l

The current navigation announcement
is repeated.

ﬁ
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Navigation

Route guidance

Muting current voice instructions

» Press A

The current announcement is stopped.

You will hear the next navigation
announcement normally.

Switching voice instructions On /Off

Switching off

» During a navigation announcement
press for 2 seconds.

You will hear a confirmation beep if the
beep tones option was activated in the
system settings (> page 201).

Themessage Voice Announcements
Muted will appear briefly. Further route
guidance takes place using only the
symbols in the display. If a new route
guidance cycle is started, the
announcements are automatically
switched on again.

Switching on again

» Press B3l

%

Navigation displays
The navigation displays are only visible
while route guidance is active.

To switch to the navigation display from
another display, e.g. from CD operation:

» Press or I

Two examples are shown below:

Display example 1:

120 mi
& Esa1-90

P82.86-2873-31US

The road you are currently driving on is
shown on the status bar, in this case I -90.
The indication 120 mi is the distance to
the next driving maneuver.

If the GPS position display (> page 154) is
active, the GPS data are shown instead of
the street name.

o

Using the multifunction steering wheel
buttons, the display unit can be
changed between km or miles (see
your vehicle’s Operator’s Manual).

e When the display unit is set to
miles, the COMAND will indicate
distances in miles (mi) or feet (ft).

e When the display unit is set to km,
the COMAND will indicate
distances in kilometers (km) or
meters (m).

ﬁ
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Important map symbols:

e Current vehicle location and direction
of travel ()
If the map orientation 2D Heading Up
(> page 153) is chosen, the arrow will
always point upward.

e The remaining route section is
highlighted in blue color.

o

The colored highlight only appears
when the system has completed the
route calculation.

Display example 2:

PARK AVE

300 ft

P82.86-2874-31US
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On the right side of the display, the symbol
for the next driving maneuver is indicated
(here: right turn).

On the very right side next to turn symbol
is the distance bar. It indicates the
distance to the next driving maneuver
(here: 300 ft).

The status bar shows the name of the
street after the driving maneuver, if
available, here: PARK AVE

The destination is marked with a flag f& on
the map, an intermediate destination is
marked with a flag showing the letter S.

Altering the map scale

The current map scale is indicated on the
left side of the status bar.

Navigation

Route guidance

o

Using the multifunction steering wheel
buttons, the display unit can be
changed between km or miles (see
your vehicle’s Operator’s Manual).

e When the display unit is set to
miles, the COMAND will indicate
distances in miles (mi) or feet (ft).

e When the display unit is set to km,
the COMAND will indicate
distances in kilometers (km) or
meters (m).

Press any soft key.
The soft key displays appear.

o

If no other action is taken within
approx. 8 seconds, the soft key
displays will disappear again.
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Navigation

Route guidance

» Press the ® or & soft key. You can select the map orientation

The map section is zoomed in or (> page 153).

zoomed out. A bar indicating the map ch ine th displ
scale appears on the status bar. anging the map display
While route guidance is active, you can

Selecting map orientation switch between split view and full view.

A symbol is shown on the bottom left side e
of the status bar.

e 2D North Up @:

Split view:
The map is shown on the left side and
information on the next maneuver on

Map is displayed facing north the right.
or or
. Full view:
e 2D Heading Up (®: * .
Dynamic map alignment, map is Full view of the map
displayed facing driving direction » Press I
pointing up The display changes with every push of
the button.

e

o

If GPS display (> page 154) is active,
information on your current position is
shown on the status bar.

Arriving at destination

SO—>—7 <"

o1m W THAMES ST
P82.86-2876-31US
When you reach the destination, you will

see the destination flag. Route guidance
ends.

%%‘%
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Navigation

Route guidance

Cancelling route guidance Continuing route guidance

» In navigation mode, press [JI- » Press [ to select No.
The inquiry menu Cancel Current > Press @.

Route Guidance? will appear.
» Press @ and confirm with Yes.

Route guidance is cancelled. The
Navigation main menu appears after a
brief delay.

o

You can continue route guidance from
the Navigation main menu
(> page 118).

Ay
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Navigation

.

During route guidance
V During route guidance

During route guidance you can use the soft  Available soft keys 5 T
keys to activate additional menus and

e Info soft key: i
displays and make settings. y > Display the soft keys.

Brings you to the Info menu.
The soft key displays will automatically > Press the Info soft key.

. St-over soft key:
disappear after a few seconds.

Brings you to the stopover destination
function (> page 149).

The Info menu will appear.

Displaying the soft keys
» During route guidance, press any soft ~ * Detour soft key: % NEW YORK CITY, NY,
key. Brings you to the Traffic Jam function OAK AVE

SO ey d e 11:57 AM, 672 mi
The k > page 147). 7 , 67

e Memory soft key: m
Brings you to the save current location m m

function (> page 151).

NAV Info
e Display soft key:
Brings you to the Display menu Pe2.86-4013:3108
m (> page 151). (@ Your destination with estimated time of
N ) arrival and the remaining distance
\\‘a * Softkey & @) A stopover destination, if entered

TRIMBLE PL Enlarge visible map section. (> page 149)

P82.86-4012-31US o Soft key Q:
Reduce visible map section.

e Coord. soft key:
Brings you to the destination
coordinates input (> page 137).

.

V

ST,
/N

e .
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Navigation

A
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During route guidance

() Displaying the route on the map » Pressthe List soft key.

If a stopover destination has been » Inthe Info menu (> page 144), press The list of the remaining roads/route
entered: the Route soft key. sections appears.

The estimated time of arrival and the The map will appear. The route ahead The road currently travelled on is at the
remaining distance to the destination is blue-colored. top of the list.

are displayed. The destination is marked with aflag @  » Press [k or M to scroll through the
When the stopover destination is on the map, a stopover destination is list.

reached, the system calculates the marked with a flag showing the letter S. Use the Page W and Page A soft keys

route to the main destination and

indicates estimated time of arrival and
remaining distance. Depending on the distance to the ()

destination, it may take some time

() to display the next or previous page.

Depending on the distance to the

Available soft keys before the route display appears. destination, it may take a few moments

o Rgute soft key: ' Displaying the route list before the route list is completed.
Brings you to the route display on the The list will only be complete when the
map. > In the Info menu (> page 144), press route is completely calculated. This is

e Mode soft key: the Route soft key. indicated by theword Destinationin
Brings you to the route mode selection The route appears on the map. front of the last list entry.

menu (> page 120).

e Setting soft key:
Brings you to the audio settings for the
navigation announcements
(> page 121).
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Navigation

Via function (soft key via)

During route guidance

If the via function is not yet active, you may
now select a via route.

With the via function you can influence

how the route is calculated.

Example:

If the via function is already active, the
message Via Already Active will
appear. You can delete (> page 147) or

You wish to travel from Chicago to New change (> page 147) the via route.
York. You can use the via function to define
whether the route will lead via Cleveland or ~ Selecting a via route

Pittsburgh.

>

You can select one via route at a time.
In the Info menu (> page 144), press

the Route soft key. A m

Cleveland
The route is shown on the map. Harrisburg
) Philadelphia
Press the Via soft key. Pittsburgh
0 Scranton, Pa.
The Via soft key has no function if the v w
route cannot offer any via routes. NAV Select Via

P82.86-2879-31US

>
>

e

Press |[E4 or ¥ to select a list entry.
Press @.

The system calculates the new route.

o

The selection list always refers to the
currently active route.

Example:

You have entered a main and a
stopover destination. First, the system
will calculate your route to the stopover
destination, so that route is the active
route.

The selection list only shows possible
via routes to the stopover destination.

ﬁ
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Navigation

During route guidance

Deleting the active via route Changing the active via route Selecting a detour
Via Active Via Active The detourfun.ctlon blocks a rouFe section
A A ahead. If possible, the system will
Delete Active Via Delete Active Via calculate a detour. You can adjust the
Change Active Via Change Active Via length of the route section to be blocked.

v | Back| v | Back| If the system does not allow you to

block a route section, the message No

NAV Select Action NAV Select Action Detour Possible is displayed
P82.86-2880-31US P82.86-2881-31US Traffic jams are identified by the driver,
» Press Y to select option Delete » Press Y to select option Change not by the COMAND. The detour
Active Via. Active Via. function may also be possible if the
> Press @. > Press @. vehicle is traveling on a road that does
not appear on the DVD.
The system deletes the via route and The list for selecting another via route
recalculates the route to the appears. Switching on
destination. . .
> Use K& or I to select the desiredvia ) Activate the soft key display (> page 144).
route.
(i » Press the Detour soft key.

If you enter a new destination, the sys- » Press @.

tem will automatically delete any active The system recalculates the route. (i ]

via route. If you have already placed a block on a
route section, Detour appears written
in black. A menu will appear instead of
the map (> page 148).

e e
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% Navigation

During route guidance

“\‘l/}" Switching off Changing the blocked route section
'//,,, » Activate the soft key display by » Activate the soft key display
I).llﬂ pressing any soft key (> page 144). (> page 144).

, » Press the Detour soft key. » Press the Detour soft key.

Use [E8 to selectitem Reset Detour.
Detour Already Set

- Press @.

0.1 mi A

Delete Detour You can now change the length of the
PozcA0ISILS Reset Detour route section to be blocked.

You can now enter the length of the route .
» Press the More soft key until the

section to be blocked.
v | Back| desired length is set.

i NAV Manual Detour » Press the Less soft key to reduce the
The route directly in front of the current 082 86.2663.31US length of the blocked route section.
position can be blocked in the range of
010 6.2 miles. » Press [ to select Delete Detour. » Press @.
» Press . The system calculates a new route
» Press the More soft key until the around the blocked route section.

desired length is set.

The blocked route section is deleted.
The system calculates the new route.

» Press the Less soft key to reduce the
length of the traffic jam.
» Press @.

The system calculates a new route
around the blocked route section.




ST (%)
% 230_Navigati US_B.fm Seite 149 Mittwoch, 8. Dezember 2004 4:37 16

A

Stopover function

This function allows you to select an
intermediate destination while route
guidance is active. A stopover destination
may be a gas station or a restaurant or any
other place. When the stopover
destination is reached, the system
calculates the route to the main
destination.

Entering a stopover destination

» Activate the soft key display
(> page 144).

» Press the St-over soft key.

The map is displayed in full view.

TRIMBLE PL

P82.86-2884-31US

Available soft keys

soft key:
Shows a list of Mercedes-Benz Centers
near your location.

Bl soft key:
Shows a list of filling stations around

you.

7] soft key:
Shows a list of parkings and multi-

storey car parks around you.

%

Navigation

During route guidance

soft key:
Shows a list of restaurants around you.

[©)] soft key:
Shows a list of hospitals around you.

More soft key:

If you press this soft key, the
Navigation main menu will appear.
Enter Stopover will appear on the
status bar.

You can now enter an stopover
destination by

e selecting one from the destination
memory (> page 156)

e typing one in the Destination Entry
menu (> page 125)

e selecting one in the Last
destinations memory
(> page 155)

e selecting a POl (> page 160)
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Navigation

During route guidance

Press a soft key, e.g. [&ll-
Press .

A list of restaurants near your location
is displayed.

o

Prior to this, a list may be displayed in
which you can select the desired
category, e.g. Barbecue/Southern,

pressing K2 or IN-
Current Position m
A

= 2.8 mi DAP'S SMOKE...

Y 6.2 mi BONE YARD B...
Page ¥
A 11 mi BDIS MONGO...
Sort

[Name v

NAV

Barbecue/Southern

P82.86-2885-31US

The arrows left from the entries indicate
the direction of the destination. The
distances indicated are straight line
distances to the destination.

» Press [§4 or [l to select a destination
from the list.

» Pressthe Details soft key if required.
Details on the destination are shown.

e Name soft key:
Brings you to name input of a stopover
destination (> page 193).

e Sort soft key:
Sorts list entries either by increasing
distance or alphabetically.

» After you have selected a destination,
press @.

The Start Route Guidance menu will
appear (> page 139).

» Press @.

The system calculates the route to the
selected stopover destination.

%

Deleting or replacing a stopover
destination

» Activate the soft key display
(> page 144).

» Press the St-over soft key.

The menu for deleting or changing a
stopover destination will appear.

Stopover Function
Already Active
A
Delete Active Stopover
Replace Active Stopover

v | Back|

NAV Select Action

P82.86-2886-31US

ﬁ

QW2
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or

o

If no stopover destination has been
entered, the full view map appears
instead of the menu. You can now
enter a stopover destination

(> page 149).

Use Y to select Delete Active
Stopover.

Press .

The stopover destination last input is
deleted. The system calculates the
route to the main destination.

Press |§@ to select Replace Active
Stopover.

Press @.

The stopover destination is deleted and
you can enter a new stopover
destination (> page 149).
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Saving the current location

The system can save the current position
as a destination in the Last
Destinations memory (> page 155).

» Activate the soft key display
(> page 144).

» Press the Memory soft key.

The current location is saved.

o

Such destinations are marked in the
Last destinations memorywith @
(> page 155). Information such as date
and time or city and street supplement
the entry (if available). You can save up
to 20 such destinations.

If a destination is to be saved for later
or repeated use, the current location
can be stored in the standard
destination memory (> page 156).

%

Navigation

During route guidance

Defining route guidance displays

» Activate the soft key display
(> page 144).

» Pressthe Display soft key.

The Display menu will appear.

You can now use the soft keys to
activate other menus.

Symbol soft key:

Brings you to the symbol display
settings (> page 152).

View soft key:

Brings you to the map orientation
settings (> page 153).




o

During route guidance

e GPS soft key:

Brings you to the Position
Display menu (> page 154).

Setting symbol displays

You can set which POls are shown as
symbols on the map.

4

(i)

You will see the symbols only if the map
scale is 0.05 mi/inch, 0.1 mi/inch, 0.2
mi/inch or 0.5 mi/inch (> page 141).
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Navigation

» In the Display menu, press the Symbo'l
soft key.

- Symbol Display
2 A
Default
m Personal
None

OCwe®

=

v

MAP Settings

P82.86-2887-31US

The available options are displayed.
» Press K4 or ¥ to select an option.
» Press .

The option is activated @.

Default option:

The map shows the default
symbols.

Personal option:

You can determine the symbols
which are displayed. The following
section explains the further
operation.

None option:

No symbols are shown on the map.
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A
ZINd

i

During route guidance

Setting personal symbol display » Press the Back soft key to confirm. )
Map View
» After selecting the Personal option, The settings are saved. A
press the Change soft key. View | gg uortclr_ UPU 8
. . eaaing Up
The list of available personal symbols is Setting map view m Bird's-Eye View @)
displayed. You can select the follwing map .
orientations: m
Meaning Symbol e 2D North Up :
Selected ] Map is displayed facing north LB Henllips
Unselected O e 2D Heading Up P82.86-2888-31US
Dynamic map alignment, map is Option Symbol
Press K4 or M to select a list entry. displayed facing driving direction on ®
pointing up
Press . Off )

e Bird’s-tEye View
The map is shown in three dimensions
with sky and horizon.

may also activate more than one > Pr t lect th
» In the Display menu (> page 151), ess R or [ to select the
symbol. pay (> pag ) deactivated option.

press the View soft key.
> Press @.

The orientation is changed.

The symbol is activated or deactivated

depending on its previous state. You Changing map view

The available options are shown.

» Press the Back soft key to confirm.

o e
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During route guidance

() » In the Display menu (> page 151), » Press the Back soft key to confirm.

A symbol is shown on the bottom left press the GPS soft key.

side of the status bar. The options On and Of f are displayed.
e North symbol @):

Automatic map toggling

The system automatically switches to split

L . iti i i h it drivin
Map is displayed facing north POSItlonADISpIay view whenever it announces a driving
View S 5 maneuver.
* gompa§s symb(|>il n®r>n nt. ma i -Off ® When the driving maneuver is completed,
ynamic map aighment, map 1S the system reverts to the full view.
displayed facing driving direction
pointing up v W
Switching the GPS info setting on/off MAP Settings
When the GPS info setting is active, the P82.86-2889-31US
following data are displayed on the status  The symbol @ indicates the present
bar: setting.
e your current position in the form of » Use button |E4 or [ to select the
coordinates option with the symbol O.
e the number of satellites currently » Press button @.
received Depending on the previous setting, the
e the height above the sea level GPS is switched on or off.

<
% % N
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Last destinations and destination memory
V Last destinations and destination memory

o——r Now you can

Last destinations memory A m y
The Last destinations memory NEW YORK CITY, NY, OAK... e start route guidance to the selected
automatically saves last destinations to ®175; D=S, 01/01/2003... Ik entry (> page 156)
which you have started route guidance. delete the selected entry (> page 156)
The memory can save a maximum of 50

save the selected entry in the
W destination memory and at the same
time in the address book

destinations.

:
You can save your current position as a
destination in the memory (I> page 122). NAV Last Destinations '
Such destinations are marked with @. P82.86-2890-31US » To do this, press the Save soft key.

Further operation is explained in

Selecting a destination from the last chapter “Save destination in the

Activating the last destination memory T
destinations memory

» Activate the Navigation main menu Notivate the last destinations list destination memory” (> page 156)
(> page 118). > Activate the fast destinations ist. o view details on the selected entry (if
» Press K@ to select menu item Last > Press [k or ¥ to select an entry. available)
Destinations. Use the Page soft keys to scroll page- » Pressthe Details soft key.
> Press @ wise through the list.

The last destinations list is displayed.
The most recent destination is at the
top of the list.

o e
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Navigation

Starting route guidance to a last
destination

» Select a destination from the Last
Destinations memory.

» Press @.
The Start Route Guidance menu will
appear (> page 139).
Deleting a destination from the last
destinations memory

» Select a destination from the Last
Destinations memory.

» Press the Delete soft key.

The destination is deleted.

Last destinations and destination memory

Destination memory

In the destination memory, you can save
destinations under freely assignable
names.

At the same time, the system saves the
data to the address book. You may later
transfer the address to the navigation
system from the address book and start
route guidance (> page 187).

Saving a destination in the destination
memory

» In the Start Route Guidance menu

(> page 139), press the Save soft key.

or

» Select a destination in the Last
Destinations memory (I> page 155)
and press the Save soft key.

The Save Destination selection menu
will appear.

%

Save Destination
A
Create New Entry
Allocate to Entry

v

NAV Destination Memory

P82.86-2891-31US

» Use [E4 or [N to select the desired
menu item.

e Option Create New Entry:

You can save the destination under
a freely assignable name
(> page 157).

e Option ATTocate to Entry:

You can save the destination under
an existing name (> page 158).

» Press @.

ﬁ
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Navigation

Last destinations and destination memory

Option Create New Entry: () You can now select between the
» Press Kl I N E4. BN or & to Do not confuse the Delete soft key 2?;522?3 Home Address and Work
select the characters. After each (deletion of the last character) with the '
selection, press @. Back soft key (deletion of the complete  » Press [§@ or ¥ to select the desired
or entry). category.

> Press one of the number keys [ to ) press I3, IEN, I and @ to select Press @.
as often as needed. symbol [ok]. The system saves the address in the
selected category. After that, the Start

Enter Destination > Press @. Route Guidance menu or the Last
Destinations memory reappear.
Name: DE| DETROIT
A
ABCDEFGHIJ 123 Home Address
KLMNOPQRST—456 Work Address

UVWXYZAOUB 789
17, :+ - be)lo o) IR

NAV Destination Memory v m

P82.86-2892-31US

. NAV Destination Memory
» To delete the character last input,

press the Delete soft key. PonaeRaREILS

o e
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Last destinations and destination memory

Option ATTocate to Entry » Press . Selecting a destination from the
» Use |[KI IE M and B4 to select an The selected entry is updated with the destination memory
entry to which you wish to assign the new address. » Activate the destination memory.
destination address. The system updates the entry in the » Press K, IX ¥ and B4 to select
Destinations memory and in the the desired entry.
< 2 > m address book. After that, the Start N
s Ow you can
DETROIT Route Guidance menu or the Last
Destinations memory reappear. e start route guidance to the selected
o
destination
Activating the destination memory o delete the selected destination
v BT 5 Activate the Navigation main menu e view details on the selected
NAV Destination Memory (> page 118). destination (if available)
pise2sossius > Press [ or [K to select menuitem 74 go this, press the Details soft key.
Press @. Destination Memory.

» Press [ or K@ to select one of the > Press @.
categories Home Address and Work

The destination memory will appear.
Address.

—$- —+|®
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Navigation

Last destinations and destination memory

Starting route guidance to a destination  Deleting a destination in the destination If you do not wish to delete

from the destination memory memory > Use [ to select No.
> Selef:t a.destination from the > Selef:t a.destination from the > Press @.

destination memory. destination memory.
» Press @. » Pressthe Delete soft key.

The Start Route Guidance menu will A prompt message appears.

appear (> page 139). > Press @ to confirm Yes.
The system deletes the navigation
entry in the destination memory and in
the address book. Other data in the
address book are preserved.

o e
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Navigation
POls (Points of Interest)
V POls (Points of Interest)

This function allows you to select Points of o
Interest such as gas stations, parking M" bt (OGN [
facilities, shopping centers and many

more.
WABCDEFGH 1) 123
Entering POls g < LMNOPQRS T - 4 5 ¢ I
u

. o . VWXYZ-"., 789
» Activate the Navigation main menu m & 0 W
(> page 118).
) NAV Enter City (USA)
Press [E@ to select menu item POIs. Y—
et >
Press . e Ifyou have not entered a location in the
The POIs main menu will appear Destination Entry menu prior to
(> page 161). pressing the POIs soft key:
or The system uses the location last
entered, e.g.: NEW YORK CITY. You
> Press [IX3. can select a POl near that location.

You can now select a POl visible on the
map (> page 164).

» In the Destination Entry menu
(> page 124) or on the map, with the
soft keys displayed, press the POIs
soft key.

If no location has ever been entered,
the system naturally cannot use one. In
this case, you can select a special
destination near your position.

If you have entered a location in the
Destination Entry menu prior to
pressing the POIs soft key:

e

You can select a POl near that location.

In either case, proceed as described in
paragraph “Selecting a POl around
your current location” at “Selecting a
POI category” (> page 161).

ﬁ

S
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POls main menu e Different City:
Select a Point of Interest around any
o location (> page 162)
Current Position pag .
Different City e Global Destinations:

Global Destinations
Select a POl from regional categories

(> page 163). Initially, selection is

v w restricted to the region in which you
presently are. However, you can
NAV POIs change the region.

P82.86-2895-31US
Selecting a POl around your current

You can select between the following location

menu items:
» In the POl menu, select menu item

Current Position.
Selggt a POl around your current > Press @.
position.

e (Current Position:

Alist with POI categories is shown from
which you can select a category.

o e

Navigation

POIs (Points of Interest)

Selecting a POl category

BOSTON, MA
A

»- Airport

99 Amusement Park
T ATM / Cash Machine

@ Auto Club
é™Bank
v
NAV Enter POI
P82.86-2896-31US
> Press K4 or [P to select a POI

>

category.

Press @.

A list with POls is shown from which
you can select a destination.

o

You can select a POl around your loca-
tion up to a distance of 10 miles, or 60
miles if category airport is chosen.
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Navigation
POls (Points of Interest)

Selecting a POI » Pressthe Details soft key if required. Selecting a POl around another
Details on the destination are shown. location
BOSTON, MA .

A e Sort softkey: » In the Point of Interest menu
1.6 mi LOGAN INT'L AIRPORT Sorts list entries either by increasing (> page 161), select menu item
1.8 mi LOGAN INT'L-TERMINAL A . . Different City.
2.0 mi LOGAN INT'LTERMINAL . MRk distance or alphabetically. . o
1.9 mi LOGAN INT'L-TERMINAL B... I8 » Press . » Enter a location as described in
2.1 mi LOGAN INT'L-TERMINAL C... — ) ) paragraph “Entering destination

v The Rout1es(;mdance menu will appear address” (> page 125).

NAV Airport (> page 139).

P82.86-2897-31US sa AARONSBURG, PA
» Press [E@ or [ to select a POI.

ABCDEFGHI )

KLMNOQPQRST -

UVWXYZ-" .,

& BA] _Back|

NAV Enter City (USA)

P82.86-2859-31US

% ﬁ
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» After entering the location, proceed as
described in paragraph “Selecting a
POI around your current location” at
“Selecting a category” (> page 161).

Selecting a POl around a global
destination

» In the POl menu (> page 160), select
menu item Global Destinations.

The list of global destinations
categories will appear.

Now you can

e select a special destination category
(> page 163)

e select another region (> page 163)

%
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Selecting another region

Global Destinations (USA)

»- Airport
99 Amusement Park
Border Crossing
A¥* Freeway Exit

% Ski Resort

v | _Back|

Enter POI

NAV

P82.86-2899-31US

» Press the Region soft key.
The Select region list will appear. See
“Selecting a region” (> page 124).
Selecting a category

> Press K4 or ¥ to select a category.

Navigation

POIs (Points of Interest)

> Press @.

Depending on the number of POls in a
category, you can now enter a POI
name or select a POL.

Entering a POl name

» Proceed as under “Entering destination
address” (> page 125).

o

If you do not know the name of the PO,
you may avoid the entry.

» To do this, press @ longer than 2
seconds.

You will hear a confirmation beep if the
beep tones option was activated in the
system settings (> page 201).

Following the entry or avoidance of the
entry, you can select a POI.




o
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Navigation

POls (Points of Interest)

Selecting a POI

BOSTON, MA
A

1.6 mi LOGAN INT'L AIRPORT

1.8 mi LOGAN INT'L-TERMINAL A
2.0 mi LOGAN INT'L-TERMINAL B...
1.9 mi LOGAN INT'L-TERMINAL B... Sort

2.1 mi LOGAN INT'L-TERMINAL C...
g v

NAV Airport

>

P82.86-2897-31US

Press [E@ or [IY to select a POI.

The list also shows the straight-line
distance to and the direction of the
Point of Interest.

Press the Details soft key if required.

Details on the POl are shown.

>

Press @.

The Route Guidance menu will appear
(> page 139).

Selecting a POl on the map

>
or

>

Press [P

In the Destination Entry menu
(> page 124), press the Map soft key.

The full view of the map will appear.
Your current position and the special
destinations are indicated by symbols.

(i ]

You will see the symbols only if the map
scale is 0.05 mi/inch, 0.1 mi/inch,
0.2 mi/inch or 0.5 mi/inch

(> page 141).

o

You can define which symbols will be
shown on the map (> page 152).

o

If the system does not find any POI, the

message No POIs Found will appear.

If required, move the map pressing
KON EEN-d@

If the soft key displays are hidden,
press any soft key.

The soft key displays will appear.
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POIs (Points of Interest)

S,

> Press @.

The Route Guidance menu will appear
(> page 139).

g_ ® DEA E127TH ST

P82.86-4020-31US
» Usethe Next or Prev. soft key
One of the POl is marked in color. The to select the desired POI.

name belonging to it and the distance  p  Pressthe Details soft key if required.
are shown on the status bar.

P82.86-4019-31US

» Press the POIs soft key.

Details on the POI selected are shown.

§//é

o e
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Software Updates

o

V Software Updates

You can update the system with a new Ejecting After that, the COMAND loads the
navigation DVD. The new DVD may include > Press Y. software on the DVD.

new maps and/or new device software.
The navigation computer ejects the Shortly after that, the progress bar

() DVD appears. After some time, the progress

0,
Updating may take several minutes. bar reaches 100%.

During updating, the operation of i The update is completed. You can now
COMAND is restricted. You cannot If you do not remove the DVD from operate the navigation system again.
switch off the system. the slot W|th|n around 15 seponds, the The message Navigation Being

. . COMAND will pull the DVD into the ) .
After updating, the car should remain drive Activated Please Wait appears after

outside under open sky for 10 minutes the system is switched on:
with the ignition on.

Loading e for a short time
Starting an update » Insert the new navigation DVD into the The update is completed. You can now
DVD slot with the label side up. operate the navigation system again.
> Switch the COMAND on (i> page 27). P P sation system a8
The message Navigation Bein e foralonger time
DVDs are loaded and ejected at the Activat i P g Wait wil g 8
navigation computer. ctivate ease Wartwi COMAND was unable to update the
appear. software.

o

The navigation computer is located on
the left side in the trunk (> page 115).
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Service main menu
SMS (Mail)
Address book

Tele Aid*

Entering data
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Service main menu

V Service main menu

Activating the Service main menu You can use the soft keys to open other e Pic Off soft key:
menus

» Press BEIM- » Pressthe Pic Off soft key.
e SMS soft key:
Opens the SMS Inbox Folder

The Service main menu will appear. The screen is switched off.

(> page 169). » Press any soft key or button.
Pic Off
m - o The screen is switched on again.
You can use this function if you havea  ® Systemsoft key: .
Mercedes-Benz specified integrated Opens the system settings
mobile telephone (TDMA/CDMA or (> page 198).
GSM).
« Addr Bk soft key:
P82.86-4021-31US Opens the address book (> page 176).

Service main menu

.

2

e 4|
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Vv SMS (Mail)
O

The functions described here apply if
your vehicle is equipped with mobile
phone cradle* and a Mercedes-Benz
specified mobile phone*.

With the SMS Inbox Folder you can receive
SMS messages provided that SMS
messaging is available from your mobile
phone service provider.

o

If you have received new SMS
messages, < is displayed on the
status bar. Additionally, a message
received tone is played.

Long/combined SMS which contains
more than 160 characters are not
supported. Only the first 160
characters from a combined SMS will
be downloaded.

%

o

If another system is active (e.g. radio),
a window appears when SMS mail is
coming in. The message New
message(s) will appear. Press @ to
confirm.

SMS Inbox
» Activate the Service main menu

(> page 168).
Press the SMS soft key.

The Inbox will appear. The message
Now Downloading... will appearin
the status bar while SMS are reading
in, e.g. after the telephone is switched
on (> page 92).

SMS (Mail)

Inbox m

o —
& Paula

v | Back|

23.03.04 - 15:11

P82.86-4022-31US

The message Empty appears

e during download process - the
status bar displays Now
downloading...

e if no SMS messages are stored on
the mobile phone* - the status bar
displays No message

Otherwise the Inbox is sorted in
chronological order, the most recent
message is at the top of the list. The
status bar shows date and time of the
message.

.
ﬁ
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t

SMS (Mail)
One line is provided for each message. Switching between subject and sender » Pressthe Display soft key if an
Symbol @ = Message unread » In the SMS Inbox (> page 169), press entry is abbreviated as . . ..
Symbol €4 = SMS message the Subject soft key. Back to the Service main menu:
The first characters of the message » Press the Back soft key.
Scrolling through the SMS Inbox: text are displayed.
» If enough messages are shown in the » Pressthe Display soft key if an
list, press the Page ¥ or Page A entry is abbreviated as . . ..
soft key. or

In the SMS Inbox, you can: » In the SMS Inbox, press the Sender

e switch between subject and sender soft key.
e read a message (> page 171) The senders of the messages are
displayed.

e delete a message (> page 175)

o

If a sender is already saved in the
phone book, the name is shown in the

e inbox

e when you read the message
(> page 171).

.

2

e 4|
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Reading SMS message received Switching between text and sender

» Inthe SMS Inbox Folder (I> page 169),
press [y or [E8 to select a message.

» Press @.

» Pressthe Sender soft key.

2

From +491721111980

3 encer

Arriving at 3:35 PM at

the La Guardia Airport.
DAN
v [ Back]
SMS +491721111980 oann
\'%4 m P82.86-2908-31US

SMS +491721111980 ]l Sender display
P82.86-4025-31US The sender is displayed. If the name of
Text display the sender is saved in the phone book,

the name is displayed. If not, the phone

Scrolling through the message text: number is displayed.

» If the message is long enough, press
the Page Y or Page A soft keys.

Line-by-line scrolling through the message
text:

» Press [N or K&

e

SMS (Mail)

Returning to text display
» Pressthe Text soft key.

If the name of the sender is saved in
the phone book, the name is displayed.
If not, the phone number is displayed.
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SMS (Mail)

Saving a sender phone number In the mobile phone internal memory*  Input via selection menu

You can save a phone number » Press @ to confirm Cel1 Phone. » Press the Keypad soft key.
e in the mobile phone internal memory* An entry menu will appear. The selection menu appears.
or » Enter the data using the selection
, Eor BTG [ OK| menu (> page 193).
¢ in the address book. A
in the Sender disol 71 Surname: | After you have entered the data, the
> in s: thenssr elzpf?;((D page 171), s JE e entry menu is displayed again. You can
pre e Save soft key. .
select the next data field and enter
Keypad Delete
— | Delete IR
ave Number v Back _
A Confirming the entry
Cell Phone M —anil
oo Book S\ - > Press @ or press the OK soft key.

P82.86-4052-31US
The system exports the surname, the

If a sender is already saved in the address
name and the telephone number. The

book, the name is shown in the number

' text field. If not, the number will appear. message Transmitting Data to
Ready Telephone is displayed.
S LRy s > Press ¥ or K@ to switch between the o
P82.86-4026-31US data fields Surname and Number. I transmn;&gn '; succéesful,s'[he il
: message Data Has Been Saved wi
Save number selection menu You can enter data in a field using the appear and the Sender display is
12-keys keyboard (il - Il or the displayed again.

selection menu.

- —+|®
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If transmission is not succesful, the
message Error Occured While
Saving Data appears.

» Press @ to confirm.
The Sender display is displayed
again.
In the address book

You can create a new address book entry
or add the phone number to an existing
address book entry.

» In the Save number selection menu
(> page 172), use |E@ to select
Address Book.

> Press .

Save Number
A
New Entry
Addition

v [ Back

Ready

SMS +4989333 -=n0l

P82.86-2914-31US

Option New entry:

> Press @.
Store Number As
A
Cell
Work
Home
v | Back]

Ready

SMS +4989333 -=n([]

P82.86-2915-31US

%

e

SMS (Mail)

> Use [IY or B4 to select a desired

phone number type.

» Press @.
Enter Name m
A
Surname: |
Name:

Number: +4989833
Delete

<

Ready

SMS -=n0l]

P82.86-4027-31US

Alist with three data fields is displayed.
If a sender is already saved in the
phone book, the name is shown in the
Surname text field. The number will
appear in the Number field.
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SMS (Mail)

» Press [ or B to select a data field. If transmission is successful, the Option Addition:

message Data Has Been Saved will > Use K@l to select Addition.

You can enter data in a field using the
8 appear and the Sender display is

12-keys keyboard (il - I or the

i i » Press @h.
selection menu. displayed again. @
. . The address book will appear.
Input via selection menu o
> Press the Keypad soft key. If you do not enter a surname or name, < P >
. the system saves the senders number A
The selection menu appears. in the address book under the Other m  Paula
» Enter the data using the selection category. Display
menu (> page 193).
Af h d the d h If transmission is not successful, the
ter you a.ve gntere the .ata,t € message Error Occured While v W
entry menu is displayed again. You can Saving Data —
select the next data field and enter ’ SMS Add To —=n0[]
data. > Press @ to confirm. P82.86-4053-31US
Confirming the entry The Sender display is displayed » Selecting an address book entry
again. > page 177).
» Press @ or press the 0K soft key. 8 (> pag )
» Press @.
The system exports the surname, the
name and the telephone number. The The selection list with the phone num-
message Transmitting Data to ber types is displayed.

Telephone is displayed.
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t

SMS (Mail)
» Use [N or B8 toselectCell,Workor Overwriting an entry: Deleting a SMS message*
Home.
> Press @. » In the SMS Inbox Folder (> page 169),
> Press @. The system overwrites the existing use ¥ or K4 to select a message.
If the address book entry does not con- number and the message Data » Press the Delete soft key.
tain a phone number of the previously Has Been Saved is displayed and The Delete dial "
selected number type, then the system the Sender display is displayed € belete dialog will appear.
will add the number to the entry and again. > Press @ to confirm with Yes.
f[he.message Data Has Bee.n Save.d If you do not wish to overwrite the entry The message is deleted.
is displayed and the Sender display will
appear. » Use i to select No. If you do not wish to delete the message
If the address book entry already > Press . > Press i to highlight No and then
contains a phone number of the The Sender display is displayed press @.
previously selected number type, the again. or

inquiry Do you want to Overwrite
Entry? will appear. » Press the Back soft key.
The SMS Inbox Folder will appear and

the sender is still marked.

o -
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Address book

V Address book

The address book contains the entries e New address book entry (> page 185) ()

saved on the.mobile phone internal « Delete address book entry Entry with symbol g):

memory and in the address book. (> page 186) A spoken name is assigned
Activating the Address book menu (> page 180).

_ _ i Entries in the address book )
» Activate the Service main menu » Open the Address book men. Entry with symbol g:

(> page 168). This is a mobile phone internal memory
entry. Such entries have a maximum of

» Press the Addr.Bk soft key. A
y a - > m one name and one telephone number.
The A k ill . i P .
e Address book menu will appear : ﬁﬁh'm Entry without symbol:
You can use the following functions in the Aleimh Entry which you have manually entered
Address book menu: B Amelie into the address book or imported from
B Andreas h the mobile phone internal memory.

e Select entry (> page 177) ]

' . m ¥ These entries are called “address book
e View details of address book entry AddrBk Roady entries” in this description.

(> page 178)
P82.86-4030-31US
e View details of mobile phone internal Address book menu
memory entry (> page 182)
Above is a sample display. It shows a
list of entries with names starting with
the letter A. The list is sorted in

alphabetical order.

@%

2

e 4|
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> After that use Y or K@ to select the

Selecting an entry desired ent
esired entry.

Selecting an initial letter " o
with [Kll and I If you hold |4 or KA, scrolling is
» Press |KI or I one or several times. accelerated.

With every push of the button the
display changes to the next possible
letter. At the end of the letter list The number keys are labelled with the let-
follows the category Additional. ters which can be selected.

Here, all entries without names or with > Press, e.g. .

names starting with a special character

With the number keys

(e.g. +, I, * etc.) are put together. The system displays a window above

the status bar which shows the letters
0 G, Hand I. After that, the address book
If you hold n or u, Scro”ing is list with the letter G is dlsplayed

accelerated.

o -

>

e

Address book

To select, e.g. the letter H, press i
twice in quick succession.

After that use ¥ or [ to select the
desired entry.

o

If you hold [IY or KA, scrolling is
accelerated.
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t

Address book

Play &) soft key:
Plays back a spoken name
(> page 181).

You can use the soft key to use additional

Details on an address book entry i
functions for the address book entry.

» Select an address book entry

Genlnfo e
Surname Miller |
Privinfo
[Note | v

(> page 177). °

» Pressthe Details soft key.

The detail view will appear.

Change Entry

X

Name Jens
Cell +4917645789
http://www...

Ready

» Press ¥ or K4

You move through the data fields line
by line.

GenInfo, Co. (Company),
PrivInfo soft key:

You can view and change the contents
of the address book entry

(> page 179).

Keypad soft key:
Brings you to the input via selection
menu (> page 179).

Note soft key:
You can add a note (> page 180).

New &) and Del. g9 soft keys:

Export soft key*:

Exports parts of the address book entry
to the mobile phone internal memory
(> page 181).

Delete soft key:
The character to the left of the cursoris
deleted.

Back soft key:
Brings you to the selected address
book entry.

AddrBk Miller, Jens -=n0l You can add/delete a spoken name ()
P82.86-2924-31US to/from the address book o .
If the detail view is left by calling up
Detail view (> page 180).

another main function, e.g. by pressing
and then restarted by pressing
EZM, the previously shown detail view
is displayed again.

ﬁ

@%

AW

2
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t

%

Changing an address book entry

» Activate the detail view (> page 178)
of the desired address book entry.

» Usethe GenInfo, Co. (Company)
or PrivInfo soft keys to select the
desired address type.

A list with data fields is displayed
(name, first name etc.).

Soft key
GenInfo

Co.
(Company)

Privinfo

Available data field
Surname, Name, Cell, URL

Co. (Company name), Tel.
(phone number), E-mail,
Region, ZIP, City,, Street,
Hse No. (House number)

Tel. (phone number),
E-mail, Region, ZIP, City,
Street, Hse No. (House
number)

> Press |4 or K to select a data field
(e.g. Surname).

» Press K or [ to move the cursor
within the data fields.

You can enter data in a field using the 12-

keys keyboard (JJilll - @) or the selection
menu.

Input via selection menu
» Press the Keypad soft key.

The selection menu will appear.

- Change Entry
Surname: MiAcheI|
mabcdefgvhij 123m
e OISR -

[Note  IERENERSN - MIJEA]  Back|

Ready

AddrBk Miller, Jens -=n0

P82.86-2925-31US

Address book

» Enter the data using the selection
menu (> page 193).

After you have entered the data, the
entry edit menu is displayed again. You
can select the next data field and enter
data.

Input via 12-button keypad

> Use - to enter the data
(> page 195).

Ending the data input

» When all data are entered, press the
Back soft key in the entry edit menu.

The data are saved. The corresponding
address book list will appear.
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Address book

Adding a note » Enter the data using the 12-keys Adding
. # i
You can add a note to an address book keyboard (",. L) or. the selection (7 )
entry menu, then finish data input.
’ You cannot add a spoken name to a
> Activate the detail view (> page 178)  Spoken name for an address book entry mobile phone internal memory entry in
of the desired address book entry. . . . . the address book.

If your car is equipped with the Voice

» Press the Note soft key control system*, you can

» Activate the detail view (> page 178)
A e add a spoken name to the address of the desired address book entry.

v
k ent
Member golf team. | book entry » Press the New g soft key.

e play back the spoken name
e delete a spoken name

Keypad Delete . .
- - Using the Voice control system*, you can  p Speak the name after each request.
then have a number dialed by saying the
Ready _ corresponding name (refer to Voice

AddrBk Miller, Jens —unl] ) .
control System Operation Guide).
P82.86-2926-31US

The system asks you to speak the
name twice.

After the second time the name is
stored.

e Newline soft key:
Inserts a line feed in text.

e Keypad soft key:
Brings you to the input via selection
menu (> page 179).
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Playback

>

Activate the detail view (> page 178)
of the desired address book entry.

Press the Play &) soft key.

The spoken name is played back.

Deleting

>

%

Activate the detail view (> page 178)
of the desired address book entry.

Press the Del. &) soft key.

You are asked if you really wish to
delete the name.

Answer Yes after each request. Refer
to Voice Control System Operation
Guide.

Exporting an address book entry*

You can export the telephone numbers of
address book entries to the mobile phone
internal memory.

>

>

Activate the detail view (> page 178)
of the desired address book entry.

Press the Export soft key.

o

The Export soft key will not appear if
the selected address book entry does
not contain a telephone number or if no
device can receive data.

A list of possible devices is displayed.

Address book

Press [y or K8 to select a target
device.

Press .

The system exports the name and the
telephone number. The message
Transmitting Data is displayed.

The message Send Failed will
appear if a transmission error occured.

o

The entry to be exported must not
contain more than three phone
numbers. If the entry has been
exported to the mobile phone internal
memory, for example, then the
telephone book will have three entries
of the same name, but with different
phone numbers. The entries are
marked with the symbol Private (home)
number symbol (> page 104).
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Address book

Details on a mobile phone internal
memory entry

» Select an address book entry with the
symbol g (> page 176).

» Pressthe Details soft key.

The detail view will appear.

Change Entry

A
Name  Seng |
No. 0172210902

v

Ready
Pager -unll

AddrBk

P82.86-2927-31US
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You can use the soft keys to use other
functions for the mobile phone internal
memory entry:

e Keypad soft key:
Changes a mobile phone internal
memory entry (> page 182).

e Import soft key:
Imports a mobile phone internal
memory entry into the address book
(> page 183).

Changing a mobile phone internal
memory entry

If you change a mobile phone internal
memory entry in the address book, the
entry is automatically also changed on
the mobile phone internal memory.

» Activate the detail view of the desired
mobile phone internal memory entry.

A list with two data fields is displayed
(name and phone number).

%

e

» Press |4 or B to select a data field

(e.g. the name field).

You can enter data in a field using the

12-button keypad (JJli] - IE) or the
selection menu.

Input via selection menu

» Press the Keypad soft key.

The selection menu will appear.
Enter the data using the selection
menu (> page 193).

After you have entered the data, the
entry edit menu is displayed again. You
can select the next data field and enter
data.

Input via 12-button keypad

Press buttons - to enter the
data (> page 195).
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Ending the data input
Import Entry

» When all data are entered, press the A

Back soft key in the entry edit menu. Create New Entry
Add To

The data are saved.

Importing a mobile phone internal v w
memory entry —

AddrBk Seng —=n0[

P82.86-4034-31US

Mobile phone internal memory entries only
contain a name and a telephone number.

You can import mobile phone internal > Press 4 or K4 to select between
memory entries into the address book and Create New EntryandAdd To.
enter additional data. > Press @.

» Activate the detail view of the desired
mobile phone internal memory entry
(> page 182).

» Press the Import soft key.

o -

e

Address book

Option Create New Entry:

The system automatically takes over name
and number of the mobile phone internal
memory entry. You only need to define the
name and surname under which the
system is to store the phone number.

» Press @ or press the 0K soft key.

If the current phone number’s category
isnot Cel T, Work or Home a selection
menu will appear.

» Select a number type under which
the system is to store the phone
number.

> Press K4 or ¥ to select an entry.
> Press @.

The system imports the data. The
message Entry Imported to
Address Book will appear.
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Address book

Option Add To: If no entry exists for the number type,

You can now select an address book entry

the system will import the data.

to which the system is to add the phone If an entry exists, the system will ask
number of the mobile phone internal whether you wish to overwrite the
memory entry. entry.
» Select an address book entry Overwrite the entry

(> page 177). » Press @.
> Press @. The system imports the data.

If the current phone number’s category
isnot Cell, Work or Home a selection
menu will appear.

» Select a number type under which
the system is to store the phone
number.

Press |[E4 or ¥ to select an entry.
Press .

e

If you do not wish to overwrite the entry

» Press [ to select No.
or
» Press the Back soft key.

You can now again select a number
type.

ﬁ

AW
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Address book

New address book entry You can use the softkey to use additional ~ » Press [ or K to select a data field
> In the Address book menu functions for the address book entry. (e.g. Name).
(> page 176), press the New soft key. e Genlnfo, Co. (Company),Privinfo You can enter data in a field using the
. _ - K3
The entry creation menu will appear. and Keypad soft key: 12 keys keyboard (il - IEl) or the
You can create a new address book selection menu.
Genlnfo | New Entry entry. Input via selection menu
A o Note soft key:
Co. Play &) » Press the Keypad soft key.
[F | zl;rmnzme | You can add a note (> page 180). P y
The selection menu appears.
Cell [ Exeort o New g)orDel. g soft keys: PP
Keypad URL You can add or delete a Spoken name » Enter the data USing the selection
[Note | v [ Back| to or from the address book menu (> page 193).
JE— i (> page 180). After you have entered the data, the
- Play @) soft key: entry creation menu is displayed again.
P82.86-2928-31US m .
) ) ) o Plays back the spoken name You can select the next data field and
A list with data fields is displayed (> page 181). enter data.

(Surname, Name, Cell, URL).

e [Export soft key:
Exports parts of the address book entry
to the mobile phone internal memory
(> page 181).

o -




g%% 230 Service US B.fm Seite 186 Mittwoch, 8. Dezember 2004 4:40 16

Address book

Input via 12-button keypad Option No:

Deleting an address book entry
» Press il - [l to enter the data o » Press I to select No.
(> page 195).

_ ] If you delete a mobile phone internal or
Ending the data input memory entry in the address book, the > Press the Back soft key.
» When all data are entered press the entryis automatically also deleted from .
’ . . The entry is not deleted.
Back soft key in the entry creation the mobile phone internal memory. y
menu.

In the Address book menu, select the

The data are saved to the address entry to be deleted (> page 177).

book.
» Press the Delete soft key.

An inquiry will appear.
Option Yes:
» Press .

The entry is deleted.

.

2

e 4|
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Using an address book entry
in other system modes

If the address book entry offers
appropriate data, it may be used in other
system modes such as telephone and
navigation.

» Press K IE. I or B4 to select the

desired entry (> page 177).
» Press @.
or

» In the detail view (> page 178), press
@ longer than 2 seconds.

You will hear a confirmation beep if the
beep tones option was activated in the
system settings (> page 201).

The selection menu appears.
Selections appearing will depend on
the data available for a given entry.

g%% 230_Service_US_B.fm Seite 187 Mittwoch, 8. Dezember 2004 4:40 16

Use Entry
/A
Cell Phone
Phone (work)
Phone (home)
® Navigate to Work Addr.
® Navigate to Home Addr.
v

Ready

+491795111807 -=n0l]

AddrBk

P82.86-2929-31US

Using an address book entry to dial a
number

You can have a phone number dialed which
is saved in the address book.

> Press [ or B to select a phone
number.

> Press .

Dialing will begin. You can then make
your telephone call.

You will find more information in
chapter “Telephone”.

%

e

Address book

Starting route guidance to an address
book entry

You can transfer an address to the
navigation system and start route
guidance.
i
This function is only available for
addresses which are saved in the
navigation system’s destination
memory (> page 155). The COMAND
saves addresses not only in the
destination memory, but at the same
time in the address book.
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Address book

» Press [y or K4 to select an entry
which allows route guidance
(navigation).

» Press @.

The system changes to the navigation
system and calculates the route.

o

The route is calculated with or without
traffic routes selected for the
destination (> page 120).

You will find more information in
chapter “Navigation”.

e
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V Tele Aid*

Tele Aid* incorporates the following
functions:

%

Emergency call
Roadside Assistance
Information call
Remote Door Unlock

Stolen Vehicle Recovery

o

To use Tele Aid*, the Tele Aid service
must be subscribed to and properly
activated. If you have any questions
regarding activation, please call

the Response Center at 1-800-756-
9018 (in the USA) or 1-888-923-8367
(in Canada).

The Tele Aid system is operational
provided the Tele Aid service was sub-
scribed to and properly activated.
Additionally, the vehicle’s battery must
be charged, properly connected, not
damaged and cellular service and GPS
coverage must be available.

General

The speaker volume of a Tele Aid call can
be adjusted using the volume control on
the COMAND (> page 98) or the and
Bl buttons on the multifunction steering
wheel.

During a Tele Aid call, all audio sources are
muted. The telephone is turned off and no
SMS messages can be received or
transmitted.

During a Tele Aid call, the used Network
Type (“A” for analog network or “D” for
digital network) and the signal strength are
displayed on the lower right corner of the
COMAND display.

Tele Aid*

Emergency call

An emergency call is initiated
automatically in the event emergency
tensioning devices (ETDs) or air bags are
deployed. An emergency call can also be
initiated manually by pressing the |
button. Refer to your vehicle Operator’s
Manual for additional information.

Once the emergency call isin progress, the
indicator lamp in the [ button will begin
to flash. The message Connecting Call
appears on the display and all audio
resources are muted.

When the connection is established, the
message Call Connected appears on
the display. A voice connection between
the Response Center and the vehicle
occupants is established soon after the
emergency call has been initiated.
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Tele Aid*

If the Tele Aid system could not establish a
voice connection to the Response Center
(e.g. the relevant cellular phone network is
not available) the message Call failed
appears.

Should this occur, assistance must be
summoned by other means.

o

During an active emergency call,
switching to another application is not
possible.

Terminating the connection

The connection can only be terminated by
the Response Center who has answered
the call.

A\

Warning

If you feel at any way in jeopardy when in the
vehicle (e.g. smoke or fire in the vehicle, ve-
hicle in a dangerous road location), please
do not wait for voice contact after you have
pressed the button. Carefully leave the ve-
hicle and move to a safe location. The
Response Center will automatically contact
local emergency officials with the vehicle's
approximate location if they receive an auto-
matic SOS signal and cannot make voice
contact with the vehicle occupants.

Roadside Assistance

Roadside Asssistance will assist if
technical problems with your vehicle are
experienced.

Roadside Assistance can only be
requested manually by pressing the
button. Refer to your vehicle Operator’s
Manual for additional information.

After initiating Roadside Assistance, the
message Connecting Call will appear
on the display and the connection to a
Mercedes-Benz Roadside Assistance
Centeris established. All audio sources are
muted.

If the connection is established, the
message Call Connected will appear
and a voice connection between the
Roadside Assistance Center and the
vehicle occupants is established soon
after.
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If the Tele Aid system could not establish a
voice connection to a Mercedes-Benz
Roadside Center (e.g. the relevant cellular
phone network is not available). The
message Call failed appears.

o

During an active Roadside Assistance
call, switching to another application
(e.g. Navigation*) is possible.

%

Terminating the connection

Roadside Assistance calls can be
terminated using the button on the
multifunctional steering wheel or the |EX
key on COMAND. The call can also be
terminated by the Roadside Assistance
Center.

The COMAND reverts to the system last
active before a Tele Aid call was initiated.

e

Tele Aid*

Information call

Pressing the button, a call to the
Mercedes-Benz Customer Assistance
Center will be initiated. Information
regarding the operation of your vehicle, the
nearest authorized Mercedes-Benz Center
or Mercedes-Benz USA products and
services is available to you.

Refer to your vehicle Operator’s Manual for
additional information.

After initiating an Information call, the
message Connecting Call will appear
on display. The system is then establishing
a connection to the Mercedes-Benz
Customer Assistance Center. All audio
sources are muted.

If the connection is established, the
message Call Connected will appear
and a voice connection between the
Roadside Assistance Center and the
vehicle occupants is established soon
after.
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Tele Aid*

If the Tele Aid system could not establish a
voice connection to the Mercedes-Benz
Customer Assistance Center (e.g. the
relevant cellular phone network is not
available). The message Call failed
appears.

o

During an active Information call,
switching to another application (e.g.
Navigation*) is possible.
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Terminating the connection

Information calls can be terminated using
the button on the multifunctional
steering wheel or the BN key on
COMAND. The call can also be terminated
by the Customer Assistance Center.

The COMAND reverts to the system last
active before a Tele Aid call was initiated.

Remote Door Unlock and Stolen
Vehicle Recovery

For the Tele Aid services Remote Door
Unlock and Stolen Vehicle Recovery
please refer to your vehicle Operator’s
Manual for information.

ﬁ
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Entering data
V Entering data

Sometimes you need to enter data such as Input via selection menu You can enter upper-case and lower-case
names or phone numbers. The selection menu is displayed letters including special characters and
i uisdi y
numbers.

E.g.: i

& automatlczl.ly V\;hen yo.u press th? hich The following shift fields can be used to
¢ New phone book entry corresponding button ina menuin which -6 the type of the characters:

this kind of data input is possible. The

* New address book entry following display may appear if you create = Upper case

The following input types are possible: a new entry in the phone book. — Lower case
e Via selection menu = i
New Entry m [...] = Special characters

e Via 12-button keypad (> page 195) A

Name: MDD | Shifting Keys

v
ABCDEFGHI) 123 » Press I, K I K4 or N to
I <. VNOPQRST - 45 ¢ IS select the shift field [abc] .

UVWXYZAOUB 789
12, :+-(abc)Jo ok B > Press @.

Ready

TEL -=n([]

P82.86-2948-31US

o -
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Entering data

Deleting a character

New Entry m New Entry m
A A

» Press the Delete soft key.

Name: MDD | Name: MDD | .
v v The character to the left of the cursor is
abcdefghij 123 adaaamceéce €3%¥ deleted.
[ BERUECEEEEREEREY Delete [l CRREEEEEIIIERE] Delete] You can also move the cursor.
uvwxyzaouB 789 gulldjz;’ 7 _ &%#
NEIEEN e mJEa]  Back -/@()<>[@BEC) ,
— — Moving the cursor
TEL . all TEL Tl
- - » Press the Keypad soft key.
P82.86-2949-31US P82.86-2950-31US
» Press I3 EB N, K2 o to oteri X . The selection menu disappears.
select the shift field [ ]. ntering characters » Press Bl or I3
» Press . > Press [, KNl I, R or to The cursor moves to the right or left in
select the character to be entered. .
the line.
» Press .

» Press the Keypad soft key again.

The character is entered. You are back in the keypad mode and

(i ) the selection menu is displayed.

To enter a blank space, use =— .
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Entering data

Inserting a character After you pressed the key the first time,

Input via 12-button keypad oY
the character is displayed at the

» Move the cursor to the desired -~ _
e You can ente.r upper-case and lower-case bottom of the screen.
position. letters including special characters and You can see which characters you can
» Enter the character as described at numbers. enter with that key.
“Entering characters” (I> page 194). Each continuing depression of the key

Entering characters displays the next character.

Closing the selection menu * _ )
& > Press [l or [l - &Ml to enter » |If required, press key JEl-
» Press the Back soft key. characters. ] .
. . This key shifts from lower to upper
or Press a key once or several times in case
quick succession.
> Press the Keypad soft key. » Wait until the displayed character
or (i ] disappears.
» Use 3B IN K2 or to select E.g.: Key The character is entered.
the field. Press 1 x =
> Press @. Press 2 x =K
In all cases, the system enters the data. Press3x =L
Press 4 x=5

o -
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Entering data
[ Inserting a character
To enter a blank space, use the — » Move the cursor to the desired
on the key. position.

» Enter the character as described at

Deleting a character “Entering characters” (> page 194).

» Press the Delete soft key.

The character to the left of the cursoris
deleted.
You can also move the cursor.

Moving the cursor

» Press Kl or A

The cursor moves to the right or left.
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System settings

¢

System settings
Voice control system*

Reset function
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System settings
System settings
V System settings

Activating the System settings
menu

» Press B2

» In the Service main menu, press the
System soft key.

Back

Ready
System —=n0[]

P82.86-4091-31US

System settings menu

In the System settings menu you can:

set date and time

switch verification and notification
tones on and off (> page 201)

adjust display settings (> page 201)

activate and deactivate the Voice
control system* help window
(> page 203)

start Voice control system*
individualization (> page 203)

reset system settings (> page 204)

Setting the date/time

o

Exact settings of date, time and current
time zone allow you:

e correct navigation for
routes with time-dependent traffic
guidance

e correct calculation of the expected
time of arrival

Setting date

o

If time/date information is transmitted
by the GPS, you cannot set the date.
A satellite symbol is displayed on the
status bar if the system uses GPS data.
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System settings

System settings

» In the System menu, press the Time » Press [N or K& Setting the hour:

soft key. Each time the button is pressed, the
time is adjusted in increments of
1 hour.

Depending on the selection, you set
The Date/Time menu for setting date the day, the month or the year.
and time will appear.

» Press the Back soft key. Setting the minute:

Format | or «  With GPS reception:

A > Press @. Each time the button is pressed, the
The setting is saved. time is adjusted in increments of
€05/28/03 06:37 PM » 30 minutes.
v Setting the time e Without GPS reception:
[ Gl » Inthe System settings menu, press the Each time the button is pressed, the
Time Date / Time Redy 1 Time soft key. time is adjusted in increments of
1 minute.
Pez86-409231Us - p Press K or B3 to select hours or
Country soft key: minutes. > Press the Back soft key.
Can only be selected if you use the GPS. > Press ¥ or K@ or
You can select the country (> page 200).
> Press [ or [l to select day, month Depending on the selection, you set > Press @.
Y the hour or the minute. The setting is saved.

or year.

o

Time settings are not automatically
changed to daylight saving time.
Change the clock manually.

- - —ej®
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System settings

System settings

Setting date and time format > Press |4 or K4 to select a format for
date and time. | 2 -
» Pressthe Format soft key. A
) ) > Press @ Albania
The Format menu for selecting the time Algeria
and date display formats will appear. The format setting is applied. Argentina
Australia
05/28,03 03:00 PM » Press the Back soft key. A
N or >/ | Back]
DD.MM.YY ® . : =T
MM,/DD /YY o > Wait a few seconds. Time & Date / Time -=n([]
. . . P82.86-4094-31US
HH:MM (24h) ® The Date /Time menu will automatically > Press ¥ or [l to select a country.
HH:MM (AM/PM) o} appear.
v w If a country has multiple time zones,
Time Date / Time Ready Selecting the country e.g. Canada and USA, you can select
s . L the applicable time zone and, if
pe2.86.4093-31us  YOU can only use this function if you use applicable, daylight saving time
the GPS. ) ’
settings.
Option Symbol » Pressthe Country soft key.
pti y Y y > Press @.
Format selected @ The country list will appear.

The settings are applied.
Format not selected O
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System settings

System settings

Switching verification and > Press K4 or [ to select an entry. Making display settings

notification tones on and off > Press @. » Inthe System settings menu, press the

» Inthe System settings menu, press the The respective tones are activated or Display soft key.

Tones soft key. deactivated. You hear the tone when

The Tones menu will appear. you activate it.
A Option Symbol S
. Tone activated (]
Verification Tone m| VCTips .
- Notification Tone m Tone deactivated |

Display BEEE] > Press the Back soft key. =4

Display il
v w or P82.86-4096-31US
System R ) Wait a few seconds. You can use the following functions:
Pe2.86-4095-91U8 The System settings menu will * adjust the display brightness
reappear. The setting is saved. e set the display dimming

characteristics

o -




A\
2

t

g%% 230_System_US_B.fm Seite 202 Mittwoch, 8. Dezember 2004 4:41 16

System settings

System settings

Adjusting the display brightness > Release the Bright. soft key.
» In the Display menu, press the » Press the Back soft key.

Bright. soft key. or

Bright. | > Press @.
(Mode |

The brightness setting is applied.

A e > +
Setting the display dimming
characteristics
CEHE > In the Display menu, press the Mode
Display Seanm soft key.
. P82.86-4097-31US
» Press [ or IR to adjust the A
brightness. - Day Mode ©)
Night Mode O
or Automatic ®

> PresstheBright. softkeylongerthan

2 seconds. v W

Ready

The display brightness changes Display al
gradually. P82.86-4098-31US

Press K4 or ¥ to select an entry.
Day Mode

The display is continuously set to
daylight design.

Night Mode

The display is continuously set to night
time design.

Automatic

The display changes depending on the
ambient light sensor in the vehicle.

Press @.

The setting is applied. The System
settings menu will appear.

e

ﬁ

*
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System settings

Voice control system*

V Voice control system*

Activating and deactivating the Voice Voice control system* individualization

Voice control system* functions .
control system* help window

If your vehicle is equipped with the Voice Allows you to record your personal
control system*, a help window can be » Use |IY or B4 to select menu item language pattern for the Voice control
switched ON or OFF. Help Window. system*.
» Inthe System settings menu, pressthe ~» Press D (] )

VC Tips soft key. The display changes. The status of the Voice control system* individualization

The Voice control system* menu will help window is displayed on the status is only possible while the vehicle

appear. The status of the help window bar. stands still.

is displayed on the status bar. » Press [ or B4 to select the desired _

status of the help window. > Pres§ “ or ﬂ to‘select menu item
Voice Control Individualization.
A > Press @. _ .
) ) ) If available, time and date of the last
Help Window The help window is activated or individualization session are indicated
Individualization deactivated. on the status bar.
[ Back Option Symbol > Press @.
- - Activated @ The display changes.
. . Ready
VC Tips Activated -=x00 Deactivated O Follow the instructions. For additional
P2.86-4099-31U8 information, refer to separate Voice

Voice control system* menu control System* Operating

instructions.

o -
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System settings

Reset function
V Reset function

Use this function to reset the current If you do not wish to reset to the factory ()
settings of the COMAND to the factory settings .
settings The factory settings are:
o » Press @ and confirm with No. Time - Atlantic Time
The System settings menu will appear. Verification tone - On
All your personal data, e.g. address
book entries, SMS messages and Accepting factory settings Notification tone - On
gelstlnztion memory entries, will be » Press I to select Yes and press @. Display setting - Automatic
eleted.

The inquiry menu Loss of Data Are
You Sure You Want to Reset? will
appear.

» Inthe System settings menu, press the
Reset soft key.

An inquiry menu will appear. > Press [l to select Yes and press @.

The message A11 Data Has Been
Loss of Data Reset COMAND Will Now Restart

All Your Data will be will appear.

Deleted.
Do You Want to Reset?

< Yes No >

Ready

Reset e ull

P82.86-4100-31US
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Audio source
This includes the systems radio, CD
(CD drive in the control unit, CD chan-
ger*), MP3-CD and DVD (only audible).

Balance
Defines sound-center left/right.

Bird’s-eye view
The map is shown in three dimensions
with sky and horizon.

COMAND
(Cockpit Management and Data Sys-
tem)
Information and operating center for
vehicle sound and communications
systems, including the radio and
CD/DVD player, as well as for other op-
tional equipment (CD changer*, tele-
phone*, etc.).

%

g%% 230 Fachworter US B.fm Seite 205 Mittwoch, 8. Dezember 2004 4:42 16

DVD
(Digital Versatile Disc)
Digital storage medium for storing lar-
ge amounts of data.

Emergency call
This function places a call to a local
911 provider. It does not initiate a
->Tele Aid* call. Please note that the
911 emergency call system is a public
service. Using it without due cause is a
criminal offense.

GPS
(Global Positioning System)
Satellite-based system for relaying
geographic location information to and
from vehicles equipped with special re-
ceivers. Employs DVD digital maps for
navigation.

Heading Up
Dynamic map alignment, map is dis-
played facing driving direction pointing
up.

Navigation DVD
Contains all the destination addresses
(town, road, intersection, house num-
ber, special destinations) and the digi-
tal map material for a country or a
region for destination entry, route cal-
culation and destination guidance.

North Up
The map is displayed facing north du-
ring route guidance.

Provider
is the network operator who makes
available (provides) telephone services




2>

t

Roaming
For this function, the mobile phone
uses the network of a contract partner.
There are home type and non-home
type systems. The Roaming indicator in
the COMAND display indicates that a
call is being made using a non-home
type system.

Service source
This includes the systems telephone*,
navigation (voice output during desti-
nation guidance) and ->Voice control
system

SMS
(Short Message Service)
With this function you can receive, read
and delete short text messages (if SMS
service is provided by your carrier)

A\ (%)
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Soft keys

Keys that activate different functions.
Function of key depends on the selec-
ted operating mode.

Surround

Playback method resulting in an impro-
ved spatial listening experience com-
pared to conventional stereo playback.

Tele Aid*

(Telematic Alarm Identification on De-
mand)

The Tele Aid system consists of three
types of response: automatic and ma-
nual emergency, roadside assistance,
and information. Tele Aid is initially ac-
tivated by completing a subscriber
agreement and placing an acquain-
tance call. Refer also to the vehicle op-
erating instructions.

e

The Tele Aid system is operational pro-
vided that the vehicle’s battery is char-
ged, properly connected, not damaged,
and cellular and GPS coverage is avai-
lable.

Unlock code
Your unlock code prevents unauthori-
zed persons from using your telephone.
The unlock code is a number string,
which you have to enter when switch-
ing on the telephone.

Voice output
During a trip, apart from visual informa-
tions (symbol or map displays),
COMAND also provides all of the
necessary spoken route information
via voice output.

ﬁ
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Voice control system*
One of the service sources of
COMAND.
As a voice-operated control system, it
controls the COMAND systems via
voice. Refer to the separate operating
instructions.

o e
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Accepting
call 97

Activating
Address book menu 176
Destination Entry menu 124
destination memory 158
Last destinations 155
Navigation main menu 118
Service main menu 168
Settings menu (DVD operation)
sound functions* 32
System settings menu 198

ACTIVATING TELEPHONE. PLEASE

WAIT. 91
Active call 102
Adding

note 180

Address book 176
changing an address book entry
deleting entry 186

%

71

179
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details on a mobile phone internal me-

mory entry 182
details on an address book entry
exporting an entry 181

importing a mobile phone internal me-

mory entry 183
new entry 185
selecting anentry 177
using an entry in other system
modes 187
Adjusting
bass and treble 121
bass or treble control 31
brightness, contrast, color (DVD
operation) 74
display brightness 202
volume 28
Altering
map scale 141
Automatic map toggling 154
Automatic station scan 39

B
Balance 121
Balance control 29

Bass 30
Begin dialing 99
(¢

CALCRTE 139
CALL CONNECTED 189
Calling up

main menus 24
Cancelling

route guidance 143
CD

loading

into the CD/DVD drive 47

REPEAT TRACK 53, 54

TRACK MIX 54

track select 50
CD changer*

CDMIX 54

REPEAT CD 54




e

CD operation 44

fast forward/reverse 52

general information 44

playback mode 53

switching to CD mode 46
Changing

address book entry 179

map display 142

mobile phone internal memory

entry 182
CHECK SIM CARD (EMERGENCY CALL
"911" ONLY POSSIBLE WITH TEL.) 91

COMAND

switching off 27

switchingon 27
CONNECTING CALL 189
CONTINUE ROUTE GUIDANCE 118
Coordinates 137
Current vehicle location 141
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D
DATA HAS BEEN SAVED 172, 174,175
DEACTIVATING TELEPHONE 92
Deleting

address book entry 186

phone book entry 108

SMS message 175
Destination input 124
Destination memory 156
Details

on a mobile phone internal memory

entry 182

on an address book entry 178
Dialing

subsequent dialing 99
Displaying

phone book 104

route list 145

route on the map 145

subtitles (DVD operation) 73

DVD
loading

into the CD/DVD drive 65

DVD operation

DVD playback requirements 64

general information 63

E
Ejecting
Ch 47
DVD 66
MP3-CD 57
Emergency call "911" 93
Emergency call system 189
Ending
call 98,99
ENTER PIN 90
ENTER UNLOCK CODE 90
Entering
data 193
via 12-button keypad 195
via selection menu 193
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destination address 125

house number 132

intersection 131

name or number in the phone
book 107

parking 133

PIN code 95

PUK 96

street 129

telephone number 98

ENTRY IMPORTED TO ADDRESS

BOOK 183
ERROR OCCURED WHILE SAVING
DATA 174
Exporting
address book entry 181

F
Frequency band 38
Frequency range 38

G
GPS 115

H
Hands-free microphone
switching on/off 103

I
Important notes
Telephone 88

Importing
mobile phone internal memory
entry 183
Incoming call 97
L
Loading
CD

into the CD changer* 47

into the CD/DVD drive 47
DVD

into the CD/DVD drive 65
MP3-CD 56

into the CD/DVD drive 57

%

Loading/ejecting
navigation DVD 115

M
Making
display settings 201
Map orientation
2D HeadingUp 142
2D North Up 142
Memory
destination memory 156
last destinations 155
Memory functions
radio operation 40
Menu
functions 25
main area 24
soft key sections 24
status bar 24
Menu display 24
Menu system 24

&///
U
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t

MP3-CD
CD-ROM MIX 61
FOLDER MIX 61
loading
into the CD/DVD drive 57
REPEAT FOLDER 61
REPEAT TRACK 61
MP3-CD operation
folder 61
general information 55
playback mode 60
selecting a folder 58
selecting a track 58
Muting
audio 34
CD operation 53
current voice instructions 140
satellite radio* operation 81

N
Navigation
Important notes 114
Navigation announcements 121
NAVIGATION BEING ACTIVATED. PLEASE
WAIT. 166
Navigation displays 140
Navigation DVD 115
loading/ejecting 115
NAVIGATION IS NOT ACTIVE 121

NEW RTE 139
NO SERV. 90, 96
o

Opening

Audio menu 34
Operating elements
CD 14

navigation 20
radio 12
satellite radio* 16
service 22
telephone* 18
Outgoing calls 98

P
Phone book 104
PIN BLOCKED PLEASE ENTER PUK ON
CELL PHONE 95
PIN code
entering 95
POIs 160
Program category 81
PUK
entering 96
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R Saving MP3-CD track 58
Radio station current position 122 POl 161, 162, 163, 164
saving station automatically 41 destination 156 region 124
saving station manually 40 phone numbers 109 satellite radio* station 81
Reading radio station 40 street 130
SMS message 171 sender phone number 172 viaroute 146
Recalculating 139 scene/chapter 75 SEND FAILED 181
Redial 99 Selecting 75 SERVICE UNAVAILABLE 90
Roadside Assistance 190 a folder (MP3-CD) 58 Setting
ROAMING 96 address book entry 177 balance 29
Route calculation 139 CD (CD changer* only) 49 date/time 198
Route guidance 139 city 127 display dimming characteristics 202
s city center 128 route mode 120
. . country (system settings) 200 symbol displays 152
Sat?r:';z:;‘::?notes . detour 147 SIM CARD BLOCKED 95
memory functions 83 House Numbgr Area 133 SMS 169
Satellite radio* operation map orientation 142 Software Updates 166
movie 74 Sound functions* 31

automatic tuning 81 Speed-dialing 102

o e
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e

Starting Switching off TRANSMITTING DATA 108, 181
route guidance 139 COMAND 27 TRANSMITTING DATA TO
Station hands-free microphone 103 TELEPHONE 172, 174
radio station telephone operation 92 Treble 30
station selection via direct frequen-  Switching on Vv
C¥ entry (FM, AM) 38 CD operation Via function 146
station selection via number key- CD changer* 48 .
. Voice control system* 203
pad (presets) 38 CD drive 48 Helo Window 203
satellite radio* station COMAND 27 .p. L
. L . Individualization 203
station selection via direct channel hands-free microphone 103 L .
. . . Voice instructions 139
entry 82 satellite radio* operation 80
- . Volume
Switching telephone operation 92 R
between subject and sender 170 adjusting
between subtitles (DVD T at the COMAND 28
Tele Aid* 189 automatic volume control 28

operation) 73
between text and sender 171
the GPS info setting on/off 154
to CD mode 46
to MP3-CD operation 56
to telephone* operation 96

TELEPHONE NOT INSERTED 91, 96

TELEPHONE UNAVAILABLE 91, 96

TO PREVENT THE DRIVER FROM BEING
DISTRACTED, THE PICTURE IS FADED
OuT. 63




%% 230 _US Edition B 2005SIX.fm Seite 215 Mittwoch, 8. Dezember 2004 4:42 16




230_US_Edition_B_2005SIX.fm Seite 216 Mittwoch, 8. Dezember 2004 4:42 16

&




%% 230 _US Edition B 2005SIX.fm Seite 217 Mittwoch, 8. Dezember 2004 4:42 16




230_US_Edition_B_2005SIX.fm Seite 218 Mittwoch, 8. Dezember 2004 4:42 16

&




%% 230 _US Edition B 2005SIX.fm Seite 219 Mittwoch, 8. Dezember 2004 4:42 16




230_US_Edition_B_2005SIX.fm Seite 220 Mittwoch, 8. Dezember 2004 4:42 16

&




%% 230 _US Edition B 2005SIX.fm Seite 221 Mittwoch, 8. Dezember 2004 4:42 16




230_US_Edition_B_2005SIX.fm Seite 222 Mittwoch, 8. Dezember 2004 4:42 16

&




%% 230 _US Edition B 2005SIX.fm Seite 223 Mittwoch, 8. Dezember 2004 4:42 16




230 _US Edition B 2005SIX.fm Seite 224 Mittwoch, 8. Dezember 2004 4:42 16

&




